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Prezado Cliente,

Esperamos que você compartilhe do nosso sonho de transformar a indústria televisiva em uma 

indústria verdadeiramente criativa, permitindo que todos tenham acesso a vídeos da mais  

alta qualidade.

Antigamente, televisão e pós-produção de ponta exigiam milhões de dólares de investimento 

em equipamentos. No entanto, com os dispositivos de vídeo Blackmagic Design, hoje em dia até 

mesmo o Ultra HD 60p é facilmente acessível. Esperamos que você obtenha anos de utilização do 

seu novo UltraStudio, DeckLink ou Intensity e se divirta trabalhando com os melhores aplicativos  

de design e produção de TV do mercado.

Este manual de instruções contém todas as informações necessárias para que você instale seu 

equipamento de vídeo Blackmagic Design. Caso você esteja instalando uma placa PCI Express em 

um computador pela primeira vez, é recomendável pedir ajuda a um assistente técnico. Como os 

equipamentos de vídeo Blackmagic Design utilizam vídeos não compactados e as taxas de dados 

são bastante elevadas, você precisará de um armazenamento de disco rápido e um computador  

de alto nível.

A instalação deve levar aproximadamente 10 minutos para ser concluída. Antes de instalar 

equipamentos de vídeo Blackmagic Design, acesse o nosso site em www.blackmagicdesign.com/br 

e clique na página de suporte para baixar as últimas atualizações deste manual e o software do 

driver Desktop Video. Por fim, registre o seu equipamento de vídeo Blackmagic Design ao fazer 

o download das atualizações de software. Adoraríamos mantê-lo informado sobre novos recursos 

e atualizações. Talvez você possa até nos enviar o seu showreel mais recente concluído no seu 

equipamento de vídeo Blackmagic Design e enviar sugestões de melhorias para o software. 

Estamos sempre trabalhando com novos recursos e aprimoramentos, então adoraríamos ouvir  

a sua opinião.

Grant Petty 

Diretor Executivo da Blackmagic Design

http://www.blackmagicdesign.com/br
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Instruções Preliminares

Introdução ao Desktop Video
Este manual inclui requisitos de sistema para computadores e instruções de instalação 
para o hardware e software do Blackmagic Design Desktop Video, e mostra como usá-los com 
os seus aplicativos de terceiros favoritos.

O software inclui drivers, plug-ins e aplicativos como o Blackmagic Desktop Video Setup, além 
do Blackmagic Media Express para captura e reprodução. O software Blackmagic Desktop 
Video funciona em conjunto com os equipamentos UltraStudio, DeckLink, Intensity e Teranex. 

Requisitos de Sistema
Seu computador requer pelo menos 4 GB de RAM para processar vídeos com eficiência. 

Mac OS
O software Blackmagic Desktop Video é compatível com as versões mais recentes do Mac OS.

Windows
O Desktop Video é executado exclusivamente em versões de 64 bits do Windows 7, 8 e 10 
com o pacote de serviço mais recente instalado. 

Linux
O Desktop Video é executado em computadores x86 de 32 e 64 bits rodando o Linux 2.6.23 
ou mais recente. Consulte as notas de versão para obter a última lista de distribuições Linux, 
formatos de pacotes e dependências de software compatíveis.

Conectando Alimentação
Caso o seu Desktop Video possua uma fonte de alimentação externa, basta conectá-la à 
unidade e ligar a energia.

715Instruções Preliminares



DICA  A DeckLink 4K Extreme 12G também pode ser conectada à alimentação 
adicional usando o cabo adaptador fornecido com a placa. A DeckLink 4K Extreme 
12G é muito poderosa, então estamos sempre procurando maneiras de fornecer 
recursos adicionais, como placas mezanino para expandir sua conectividade. Por esta 
razão, incluímos um cabo adaptador de energia para que você possa conectar 
alimentação adicional caso uma futura expansão da sua placa DeckLink utilize mais 
energia do que o compartimento PCIe do seu computador pode fornecer.

Se você precisar fornecer alimentação externa à sua DeckLink 4K Extreme 12G, 
você pode usar o cabo adaptador fornecido. Basta desconectar a alimentação da 
sua placa de vídeo e conectá-la ao cabo adaptador. O plugue só se conectará a 
uma extremidade, portanto não há risco de conectá-lo incorretamente.

Conectando Hardware de Vídeo
Existem três tipos de conectores que a unidade Blackmagic Desktop Video pode usar para se 
conectar ao seu computador, dependendo do seu modelo. Esses tipos de conexão incluem 
Thunderbolt, USB 3.0 e PCIe. 

Conectando via Thunderbolt
Os modelos Blackmagic UltraStudio 4K e UltraStudio 4K Extreme possuem apenas duas portas 
Thunderbolt™ 2. Portanto, caso seu computador tenha apenas uma porta Thunderbolt, você 
pode usar a porta adicional para encaixar uma matriz RAID ou outro dispositivo. 

O Blackmagic UltraStudio 4K Extreme 3 inclui duas portas Thunderbolt™ 3 e o UltraStudio HD 
Mini inclui uma porta Thunderbolt 3, para velocidades de dados de até 40 Gb/s. Ao conectar 
via Thunderbolt 3, conecte sua unidade Blackmagic Desktop Video diretamente à porta 
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Thunderbolt 3 em seu computador usando um cabo Thunderbolt 3. A conexão via porta 
Thunderbolt 2 no seu computador utilizando um adaptador Thunderbolt 3 para Thunderbolt 2 
não é suportada em produtos alimentados por barramento como o UltraStudio HD Mini.

Certifique-se que seu computador seja compatível com Thunderbolt 3 procurando  
o ícone Thunderbolt perto do conector USB-C, conforme ilustrado à direita.

Conectando via USB 3.0
Conecte um cabo SuperSpeed USB 3.0 à porta USB 3.0 da unidade. Plugue a outra 
extremidade do cabo à porta USB 3.0 do seu computador. 

HDMI IN Y IN Pb IN Pr IN S-VIDEO IN VIDEO IN L AUDIO IN

AUDIO OUTVIDEO OUTS-VIDEO OUTPr OUTPb OUTY OUTHDMI OUT

R

Conectando um cabo SuperSpeed USB 3.0 no Intensity Shuttle. 

Conectando via PCIe
As placas PCIe da Blackmagic Design se conectam ao seu computador através de um 
compartimento PCIe. Consulte as informações impressas na embalagem da sua placa para 
verificar a quantidade de vias PCIe exigidas. Por exemplo, dependendo da sua placa PCIe, 
você pode precisar de um compartimento PCIe de 1, 4 ou 8 vias.

Vale notar que você pode inserir placas PCIe em slots de maior capacidade do que elas 
exigem. Por exemplo, uma placa PCIe de 4 vias pode ser inserida em um compartimento PCIe 
de 16 vias, mas não o contrário.

Caso não consiga obter as informações necessárias na embalagem, você pode encontrar a 
quantidade de vias exigidas pela sua placa, além de outras informações úteis, na página de 
especificações técnicas em www.blackmagicdesign.com/br/products
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Instale uma placa PCIe Blackmagic Design em um compartimento PCIe sobressalente.  
Caso sua placa possua um espelho HDMI, ele pode ser instalado em qualquer encaixe PCIe 
sobressalente, e se conecta à parte traseira da placa com os cabos HDMI fornecidos.

Caso sua placa inclua um cabo de expansão, basta  
plugar no conector do cabo de expansão da sua placa.

Tenha cuidado ao instalar sua placa PCIe DeckLink para não 
danificar seus componentes delicados. 

718Instruções Preliminares



Conectando um UltraStudio 4K Extreme via PCIe

O UltraStudio 4K Extreme e o UltraStudio 4K Extreme 3 também podem se conectar 
ao seu computador via PCIe usando um cabo e uma placa adaptadora PCIe. Tanto o 
UltraStudio 4K Extreme quanto o UltraStudio 4K Extreme 3 precisam ser conectados a 
um compartimento PCIe de 2ª geração no seu computador. O Blackmagic PCIe Cable 
Kit inclui um cabo PCIe e uma placa adaptadora PCIe e está disponível através do seu 
revendedor Blackmagic Design mais próximo.

Para o UltraStudio 4K Extreme original, você pode usar o Blackmagic PCIe Cable Kit 
ou adquirir uma placa adaptadora PCIe padrão na sua loja de artigos de informática 
mais próxima. 

O UltraStudio 4K Extreme possui uma porta PCIe para conexão com uma 
placa adaptadora PCIe externa instalada no seu computador.

Placa adaptadora PCIe inserida no compartimento PCIe de 2ª geração dentro do seu computador.

Conecte a outra extremidade do cabo PCIe à porta  
PCIe localizada na parte traseira do seu computador.
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Instalando o Software Desktop Video

Aplicativos, Plug-ins e Drivers
O software Blackmagic Design Desktop Video inclui todos os drivers, plug-ins e aplicativos 
necessários para usar o seu dispositivo Desktop Video. A lista abaixo mostra todos os itens de 
software que são instalados no seu computador.

Mac OS Windows Linux

Drivers Blackmagic Desktop Video Drivers Blackmagic Desktop Video Drivers Blackmagic Desktop Video

Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup

Blackmagic Design LiveKey Blackmagic Design LiveKey –

Blackmagic Media Express Blackmagic Media Express Blackmagic Media Express

Codecs Blackmagic QuickTime™ Codecs Blackmagic AVI e QuickTime™ –

Blackmagic Disk Speed Test Blackmagic Disk Speed Test –

Predefinições e Plug-ins Adobe 
Premiere Pro CC, After Effects CC e 
Photoshop CC

Predefinições e Plug-ins Adobe 
Premiere Pro CC, After Effects CC e 
Photoshop CC

–

Plug-in Final Cut Pro X – –

Plug-in Avid Media Composer Plug-in Avid Media Composer –

Atualizações Automáticas
Quando a instalação do software Desktop Video for concluída, seu computador será reiniciado 
e, em seguida, verificará o software interno do seu dispositivo Desktop Video. Se ele não 
corresponder à versão instalada no seu computador, o software solicitará uma atualização. 
Clique em “Ok” para iniciar a atualização e reinicie seu computador para completar o processo.

OBSERVAÇÃO  Caso sua placa DeckLink não esteja funcionando após uma 
atualização interrompida, consulte a seção deste manual intitulada ‘Recuperando uma 
Placa DeckLink após uma Atualização Interrompida’.

O restante da seção ‘Instruções Preliminares’ mostrará o processo de instalação do software 
Desktop Video no Mac OS, Windows e Linux. 

Instalação no Mac OS
Antes de instalar qualquer programa, você precisará ter privilégios de administrador.

1	 Certifique-se que você tenha o driver mais recente. Acesse  
www.blackmagicdesign.com/br/support

2	 Execute o instalador Desktop Video a partir da mídia incluída com o seu equipamento 
Blackmagic Design ou a partir do arquivo que você baixou na central de suporte 
técnico da Blackmagic Design.

3	 Clique nos botões “Continue”, “Agree” e “Install” para instalar o programa.

4	 Reinicie seu computador para habilitar os novos drivers do software.
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Desktop Video Installer para Mac.

OBSERVAÇÃO  Caso esteja instalando o Desktop Video no macOS High Sierra 
(ou mais recente) pela primeira vez, será necessário habilitar o Mac para usar seu 
equipamento Desktop Video durante o processo de instalação. 

Como habilitar extensões no macOS High Sierra ou mais recente:

1	 Quando instruído, clique em “Abrir Preferências de Segurança” ou abra 
“Preferências de Segurança" e clique em “Segurança e Privacidade”.

2	 Nas preferências de “Segurança e Privacidade”, clique em “Permitir” para 
habilitar o software Desktop Video no seu computador.

Clique em “Permitir” nas preferências de segurança e privacidade 
para habilitar o software Desktop Video no seu computador.

3	 No instalador Desktop Video, conclua a instalação do software ao clicar  
em “Reiniciar”.

721Instruções Preliminares



Instalação no Windows
1	 Certifique-se que você tenha o driver mais recente.  

Acesse www.blackmagicdesign.com/br/support

2	 Abra a pasta “Desktop Video” e execute o instalador “Desktop Video”.

3	 Os drivers serão instalados no seu sistema. Um alerta será exibido: “Deseja permitir 
que este aplicativo faça alterações no seu dispositivo?” Clique “Sim” para continuar.

4	 Você verá uma caixa de diálogo com a mensagem “Novo Dispositivo Detectado”  
e o assistente de configuração será exibido. Selecione “Instalar Automaticamente”  
e o sistema encontrará os drivers Desktop Video necessários.

DICA  Se você tiver uma DeckLink Quad 2 instalada em um computador 
Windows 7, o Windows Update verificará se existem versões mais recentes de 
cada drive. Neste caso específico, isto é desnecessário pois todos os drivers 
no último lançamento do Desktop Video são os mais recentes. Você pode 
desabilitar este recurso clicando na notificação e, em seguida, clicando para 
evitar que o Windows Update obtenha drivers automaticamente. Confirme sua 
escolha clicando em “Sim”. A instalação será bem mais rápida.

5	 Quando todos os drivers estiverem instalados, uma caixa de diálogo avisará que 
o dispositivo está pronto para uso. Reinicie o seu computador para habilitar os 
novos drivers.

Instalador Desktop Video para Windows.

Instalação no Linux
1	 Baixe o software Desktop Video para Linux mais recente em  

www.blackmagicdesign.com/br/support.

2	 Abra a pasta Desktop Video e navegue até os pacotes necessários para a sua 
distribuição e arquitetura. Observe que “amd64” se refere aos processadores Intel  
e AMD de 64 bits. São fornecidos três conjuntos de pacotes:

ͽͽ O pacote desktopvideo fornece os drivers e bibliotecas API principais.

ͽͽ O pacote desktopvideo-gui fornece o software Desktop Video Setup. 

ͽͽ O pacote mediaexpress fornece um simples utilitário de captura e reprodução.
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3	 Clique duas vezes nos pacotes que deseja instalar e siga as instruções na tela.  
Se você encontrar alguma mensagem sobre dependências ausentes, certifique-se  
de que elas sejam instaladas primeiro e, em seguida, execute o instalador Desktop 
Video novamente.

4	 Quando o instalador concluir o processo, é recomendável reiniciar o seu computador 
para completar o processo de instalação.

Caso você não consiga encontrar um pacote Desktop Video nativo para sua distribuição Linux, 
ou caso prefira instalar a partir de uma linha de comando, consulte o arquivo ReadMe para 
obter instruções de instalação detalhadas.

O software Desktop Video está pronto para ser instalado a partir do Ubuntu Software Center.

Atualizações
Se você não tiver instalado o software de configuração, você pode verificar se o software 
interno está atualizado usando a ferramenta de linha de comando BlackmagicFirmwareUpdater:

# BlackmagicFirmwareUpdater status

Será exibida uma mensagem semelhante a esta:

0:  /dev/blackmagic/io0 [DeckLink SDI 4K]  0x73  OK

1:  /dev/blackmagic/io1 [DeckLink 4K Extreme 12G]  0x0A  PLEASE _ UPDATE

Neste caso, você pode atualizar o software interno com o seguinte comando:

# BlackmagicFirmwareUpdater update 1

Consulte a página “man” para obter uma descrição mais detalhada do uso do comando.  
Por exemplo, para mais informações sobre o comando do atualizador do software interno, 
digite “man BlackmagicFirmwareUpdater”.

Isso é tudo que você precisa fazer para dar o ponto de partida! Agora que você instalou seu 
hardware e software Blackmagic Desktop Video, você pode começar a capturar e 
reproduzir vídeos.
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Capturando e Reproduzindo Vídeo 
Uma vez que o hardware e o software Desktop Video estiverem instalados, você pode 
começar a capturar e reproduzir clipes imediatamente. Primeiramente, plugue sua fonte de 
vídeo na entrada da sua unidade Desktop Video. Em seguida, conecte um monitor à saída.

Uma maneira rápida de começar a capturar e reproduzir é gravar um clipe no Blackmagic 
Media Express, que foi instalado no seu computador quando você instalou o software 
Desktop Video.

Configuração

1	 Conecte um monitor ou televisor à saída de vídeo do seu dispositivo 
Blackmagic Design.

2	 Conecte uma fonte de vídeo à entrada do seu dispositivo Blackmagic Design.

A B NTSC
PAL
Y

SDI OUT

HDMI OUT

REMOTE

SDI IN

ANALOG VIDEO IN

REF IN
CH 1 CH 2
ANALOG AUDIO IN

B-Y R-Y

SDI OUT

+ 12V 

SDI IN

REF IN
TC IN

Ultra Studio HD Mini

URSA Mini Pro

HDTV

Conecte um monitor de vídeo e fonte ao seu dispositivo de vídeo Blackmagic Design.

Testando Captura de Vídeo

1	 Execute o Blackmagic Media Express. Clique na aba “Log and Capture”. O formato 
do seu vídeo de entrada é detectado automaticamente e o Media Express define o 
formato do vídeo do projeto para corresponder. Sua fonte de vídeo será exibida no 
painel de pré-visualização do Media Express.

2	 Clique em “Capture” na parte inferior da janela “Log and Capture” para realizar o teste 
de captura. Clique em “Capture” novamente para finalizar o teste. O clipe captado é 
adicionado à lista de mídias no lado esquerdo do Media Express.
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Clique no botão “Capture” para iniciar a gravação.

Testando Reprodução de Vídeo

1	 Clique na aba “Playback”.

2	 Dê um clique duplo no clipe de teste. O vídeo, assim como qualquer áudio presente, 
será enviado ao monitor conectado à saída do seu dispositivo.

Blackmagic Desktop Video Setup

Apresentando o Blackmagic Desktop Video Setup
O Blackmagic Desktop Video Setup fornece um local central para ajustar configurações de 
dispositivos, além de um indicador em tempo real que exibe o vídeo conectado às entradas e 
saídas dos seus equipamentos.

Como executar o Blackmagic Desktop Video Setup:

ͽͽ No Mac OS, clique em Blackmagic Desktop Video nas “Preferências de Sistema” ou 
execute o utilitário a partir da pasta “Aplicativos”. 

ͽͽ No Windows 7, clique em Iniciar > Todos os Programas > Blackmagic Design > Desktop 
Video e clique no aplicativo Desktop Video Setup. O utilitário Desktop Video Setup 
também pode ser executado a partir do “Painel de Controle” do Windows 7.

ͽͽ No Windows 8, na página “Iniciar”, digite “Blackmagic” e, em seguida, clique no 
aplicativo Blackmagic Desktop Video Setup. O utilitário Desktop Video Setup também 
pode ser executado a partir do “Painel de Controle” do Windows 8.

ͽͽ No Windows 10, clique em Iniciar > Todos os Programas > Blackmagic Design > 
Desktop Video e clique no aplicativo Desktop Video Setup. O software Desktop Video 
Setup também pode ser executado a partir do “Painel de Controle” do Windows 10. 

ͽͽ No Linux, vá até “Aplicativos” e, em seguida, “Som e Vídeo”, e dê um clique duplo no 
aplicativo Blackmagic Desktop Video Setup. 

Quando você abre o Blackmagic Desktop Video Setup pela primeira vez, a página inicial exibe 
o seu dispositivo conectado e fornece uma visão geral de todas as atividades de vídeo nas 
conexões de entrada e saída do seu hardware. Se você estiver enviando um sinal de vídeo 
para sua entrada, ele será detectado automaticamente e o formato será exibido sob o ícone de 
entrada de vídeo.

725Blackmagic Desktop Video Setup



Se você tiver vários dispositivos de captura e reprodução Blackmagic conectados, você pode 
navegar por eles clicando nos botões de seta nas laterais da página inicial. Para ajustar as 
configurações, basta clicar na imagem do dispositivo ou no ícone de configurações localizado 
abaixo do nome da unidade. O utilitário Desktop Video Setup exibe apenas as configurações 
relevantes para o dispositivo selecionado, assim você não precisa percorrer várias páginas de 
menus para encontrar as configurações que deseja. 

Página inicial do Blackmagic Desktop Video Setup.

As próximas páginas deste manual mostrarão como ajustar configurações usando o 
Blackmagic Desktop Video Setup.

O Blackmagic Desktop Video Setup permite que você ajuste configurações  
de entrada e saída de áudio e vídeo; realize conversões ascendentes ou  
descendentes durante captura e reprodução; e fornece informações sobre o driver. 
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Configurações de Vídeo

Video Input
Clique em um ícone de conector para definir a conexão de entrada de vídeo para o seu 
dispositivo Blackmagic Design. Somente os conectores presentes no seu hardware serão 
exibidos. Quando um sinal de vídeo válido é detectado, o formato de entrada e vídeo será 
exibido na página inicial do Blackmagic Desktop Video Setup. 

Clique em um ícone para definir sua conexão de entrada de vídeo.

Use XLR Timecode

Selecione esta configuração para ler o código de tempo da entrada XLR ao invés do fluxo SDI.

Habilite a caixa de seleção para captar código de tempo da entrada XLR dedicada.

Analog Video Input Levels

Arraste os deslizadores “Video” e “Chroma” para ajustar os níveis da entrada de vídeo 
analógico para vídeo componente ou composto. Arrastar o controle deslizante de vídeo afeta o 
ganho de luma e os controles croma diminuem ou aumentam a saturação de cor. Ao utilizar 
vídeo componente, você pode ajustar os valores Cb e Cr independentemente. Clique no ícone 
de link para conectá-los caso deseje ajustá-los simultaneamente.

Video Output
Selecione o padrão de vídeo e ajuste outras configurações da sua saída de vídeo.

Configurações Gerais

�� Default Video Standard
Para usar monitoramento broadcast com Final Cut Pro X, configure o formato de saída 
para coincidir com o seu projeto Final Cut Pro X.

�� When Paused
Clique para escolher se deseja exibir um quadro completo ou um único campo na 
saída quando pausado.
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�� Video Playback
Clique para escolher se deseja exibir um quadro congelado ou uma tela preta quando 
não estiver reproduzindo.

�� During Capture
Clique para escolher se a saída de vídeo deve exibir o vídeo de reprodução ou o vídeo 
de entrada durante a captura. Caso você escolha a opção “‘Video output displays 
playback video”, sua seleção na seção “Video Playback” irá definir o que será exibido 
na saída. Optando por exibir o vídeo de entrada, o mesmo será exibido nas suas saídas.

�� During Playback
Alguns produtos Desktop Video são capazes de converter saídas de vídeo Rec. 601 e 
Rec. 709 em Rec. 2020 para televisores e monitores de vídeo. Caso seu dispositivo 
Desktop Video seja compatível com este recurso, selecione “Convert to Rec. 2020” no 
utilitário de configuração. Caso seu vídeo esteja usando o espaço de cor Rec. 2020, ou 
esteja exibindo corretamente, você pode selecionar a opção “Keep default color gamut”. 

Selecione o que deseja exibir na saída durante 
a pausa, reprodução e captura.

Saída SDI

�� Color Space
Clique para selecionar o espaço de cor para o qual deseja converter. As opções são 
vídeo RGB 4:4:4 ou Y, Cb, Cr 4:2:2.

�� 3G-SDI Formats
Clique para escolher se deseja enviar sinais 3G-SDI com mapeamento direto SMPTE 
Nível A ou enviar sinais 3G-SDI com mapeamento Nível B.

�� 1080p HD and 2K
Clique para escolher se os formatos 1080p HD e 2K são transmitidos como vídeo 
progressivo 1080p ou quadros segmentados progressivos.

Use as configurações SDI para controlar a saída do seu vídeo SDI.
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�� SDI Configuration
Selecione entre enlace único, duplo ou quádruplo para a saída SDI 3G, 6G ou 12G. 
Alguns monitores e projetores de gradação de cores profissionais aceitam apenas 
sinais com larguras de banda elevadas como 2160p60 ou DCI 4K 4:4:4 via enlace 
quádruplo. O UltraStudio 4K Extreme pode transmitir 3G-SDI de enlace quádruplo;  
e você também pode adicionar uma placa Quad SDI à DeckLink 4K Extreme 12G. 

Você pode transmitir os sinais de vídeo SDI 3G, 6G 
e 12G via enlace único, duplo ou quádruplo.

�� 8K Formats
O vídeo 8K é reproduzido via SDI de enlace quádruplo e você pode escolher o formato 
de saída de enlace quádruplo desejado. 

As duas opções disponíveis são:

Square Division Quad Split – A imagem 8K é distribuída como quatro quadrantes das 
imagens 4K em uma configuração de multivisualização 2 x 2. Cada quadrante 4K é 
fornecido via SDI usando uma conexão de enlace quádruplo e reconstruído no destino 
para formar uma imagem 8K completa. Esta também é a opção ideal caso deseje 
enviar cada saída a um monitor separado para criar uma parede de monitores Ultra HD. 

Sample interleave – Pixels alternativos de uma única imagem 8K são distribuídos 
como quatro imagens 4K separadas via SDI de enlace quádruplo e, em seguida, 
combinadas no destino para formar uma imagem 8K completa. Portanto, um benefício 
adicional deste formato é a opção de utilizar qualquer uma das quatro entradas como 
uma imagem 4K de conversão descendente.

Ao usar o dispositivo Desktop Video para reprodução 8K, 
configure seu formato de saída 8K de enlace quádruplo desejado.

Definir Saída de Vídeo Analógico
Caso o seu dispositivo Blackmagic Design possua conectores de vídeo analógico 
compartilhados, você pode escolher se prefere a saída do seu vídeo como “Component”, 
“Composite” ou “S-Video” selecionando entre as opções em “Analog Video Output”.

HDMI 3D Output 

Esta configuração determina o formato 3D para o seu monitoramento HDMI.

�� Top and Bottom
Organiza as imagens do olho esquerdo e direito verticalmente com 50% de compactação.

�� Frame Packing
Combina as imagens do olho esquerdo e direito em um único quadro sem compactação.

�� Side by Side
Organiza as imagens do olho esquerdo e direito horizontalmente com 50% de 
compactação.

�� Left Eye 
Somente a imagem do olho esquerdo é exibida.

�� Line by Line 
As imagens do olho esquerdo e direito são transmitidas em linhas de vídeo alternadas 
sem compactação.
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�� Right Eye 
Somente a imagem do olho direito é exibida.

Configure o formato da sua saída HDMI 3D.

Analog Video Output Levels

Deslize os controles “Video” e “Chroma” para ajustar os níveis da saída de vídeo analógico 
para componente ou composto. Deslizar o controle “Video” afeta o ganho de luma e os 
controles “Chroma” aumentam ou diminuem a saturação da cor. Ao usar vídeo componente, 
você pode ajustar os valores Cb e Cr independentemente. Clique no ícone de link para 
conectá-los caso deseje ajustá-los simultaneamente. 

Ajuste o deslizador Y para controlar os níveis da saída de vídeo composto analógico e os 
deslizadores Cb e Cr para controlar balanço de cores ao utilizar vídeo componente.

�� Use Betacam Levels 
Os produtos Blackmagic Design usam níveis SMPTE de vídeo composto analógico 
para manter compatibilidade com a maioria dos equipamentos de vídeo modernos. 
Habilite esta caixa de verificação para trabalhar com decks Sony Betacam SP.

�� NTSC IRE 
Selecione a configuração 7.5 IRE para o vídeo composto NTSC usado nos EUA e 
outros países. Selecione 0 IRE se estiver trabalhando no Japão ou em países que não  
utilizem a configuração 7.5 IRE. Formatos de alta definição e PAL não usam esta 
configuração. 

Habilite o caixa de verificação “Use Betacam levels” ao trabalhar com decks Sony Betacam 
SP. Selecione o nível IRE NTSC ao utilizar um formato de vídeo composto NTSC.

Reference Input

O ajuste de referência permite ajustar a temporização das saídas de vídeo do seu hardware em 
relação à entrada de sincronização de vídeo. Isso é muito usado em grandes instalações 
broadcast onde a saída de vídeo precisa ser sincronizada com precisão. O ajuste de referência 
está em amostras para que você possa obter um ajuste de tempo extremamente preciso ao 
nível de amostra. 

Um exemplo comum de como essa configuração seria usada é quando todos os equipamentos 
na sua instalação têm uma referência comum estável conectada e, portanto, todos os 
dispositivos teriam o ajuste de tempo configurado de modo que todas as saídas de vídeo 
correspondam perfeitamente. Com isso, seria possível alternar entre dispositivos em um 
roteador downstream ou switcher de produção e eliminaria qualquer falha durante o processo. 
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Caso esteja se casando a uma referência, ajuste esta configuração para 
sincronizar a saída de vídeo de acordo com a entrada de referência.

Mapeando Conectores para a DeckLink Quad 2
Caso tenha uma DeckLink Quad 2 instalada no seu computador, você pode receber ou transmitir 
sinais SDI por meio de oito conectores miniBNC independentes. Isso oferece a capacidade de 
capturar ou reproduzir oito fluxos de vídeo separados. É como contar com oito dispositivos de 
captura e reprodução em um único produto. Por esta razão, a DeckLink Quad 2 aparece no 
Desktop Video Setup como oito dispositivos DeckLink Quad individuais, o que facilita a 
configuração das suas entradas e saídas. Você pode inclusive nomear cada dispositivo e 
acompanhar qual unidade DeckLink Quad está sendo usada para um sinal de vídeo específico.

Os conectores SDI podem ser mapeados para cada dispositivo usando as configurações de 
mapeamento de conectores no utilitário Desktop Video Setup, mas é importante lembrar que 
conectores específicos são dedicados a dispositivos específicos. Por exemplo, SDI 1 é 
dedicado à DeckLink Quad (1) e SDI 2 é dedicado à DeckLink Quad (1) e DeckLink Quad (5).

Se você tiver uma DeckLink Quad 2 instalada, as configurações “Connector Mapping” 
permitem atribuir conectores SDI a cada dispositivo DeckLink Quad.

Você pode ver quais conectores SDI são dedicados a cada dispositivo DeckLink Quad consultando 
a tabela abaixo, onde você também pode verificar as opções de mapeamento para eles.

Opções de Mapeamento

Dispositivos DeckLink Quad Conectores SDI Dedicados

DeckLink Quad (1) SDI 1 e 2 ou SDI 1

DeckLink Quad (2) SDI 3 e 4 ou SDI 3

DeckLink Quad (3) SDI 5 e 6 ou SDI 5

DeckLink Quad (4) SDI 7 e 8 ou SDI 7

DeckLink Quad (5) SDI 2 ou nenhum

DeckLink Quad (6) SDI 4 ou nenhum

DeckLink Quad (7) SDI 6 ou nenhum

DeckLink Quad (8) SDI 8 ou nenhum

Vale mencionar que, ao configurar um conector SDI para um dispositivo específico, o 
dispositivo que estiver compartilhando aquele conector também será afetado. Por exemplo,  
se a DeckLink Quad (1) estiver configurada para usar o SDI 1 e 2, a DeckLink Quad (5) será 
automaticamente configurada como "Nenhum" porque o seu conector SDI compartilhado está 
sendo usado. Como alternativa, se você selecionar SDI 2 na DeckLink Quad (5), a DeckLink 
Quad (1) será definida automaticamente para o SDI 1. Por esta razão, é importante notar quais 
entradas ou saídas SDI estão sendo usadas por cada dispositivo, a fim de evitar a interrupção 
acidental da entrada ou saída de outro dispositivo.
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DICA  Se você tiver uma DeckLink Quad original na sua instalação e estiver usando 
um aplicativo SDK personalizado, você pode ter certeza de que a instalação da 
DeckLink Quad 2 funcionará no seu sistema sem necessidade de fazer alterações no 
seu aplicativo. Os recursos de mapeamento adicionais da sua DeckLink Quad 2 
permitirão que você desenvolva seu sistema existente para fornecer ainda mais 
configurações de entrada e saída se você precisar.

Configurações de Áudio

Audio Input
Clique em um ícone de conector para definir a conexão de entrada de áudio para o seu 
dispositivo Blackmagic Design. Você pode selecionar as seguintes entradas:

�� Embedded
Inclui canais de áudio como parte dos sinais de vídeo. As entradas SDI e HDMI são 
capazes de transportar áudio embutido.

�� AES/EBU
Sinal de áudio digital capaz de transportar dois canais de áudio via um único conector.

�� XLR
Conector de áudio de três pinos usado predominantemente em equipamentos de 
áudio analógico profissionais. 

�� RCA or HIFI
Conector usado para conectar áudio analógico não balanceado de e para 
equipamentos de áudio domésticos, como sistemas HiFi, leitores de DVD e televisores.

�� Microphone
A alimentação fantasma fornece alimentação através dos cabos de microfones e é uma 
fonte de alimentação propícia para os microfones condensadores. 

Habilite a opção “Use Phantom Power +48V” caso o seu microfone exija alimentação 
fantasma. Caso não tenha certeza se o seu microfone precisa de alimentação 
fantasma, é recomendável deixar esta caixa desmarcada, pois há risco de causar 
danos a microfones autoalimentados. Um LED na parte frontal do UltraStudio 4K 
Extreme iluminará quando a alimentação fantasma estiver ativa. Certifique-se de 
aguardar pelo menos 10 segundos para que a alimentação fantasma descarregue após 
ser desconectada antes de conectar um microfone de alimentação autônoma. Os 
antigos microfones de fita e microfones dinâmicos não são adequados para uso com 
alimentação fantasma.

Clique em um ícone de conector para definir sua conexão de entrada de áudio.

Arraste o deslizador “Input level” para controlar o nível da entrada de microfone.
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HDMI Audio Output
Essa configuração permite remapear os canais de áudio 5.1 do seu projeto para combinar com 
a configuração usada pelo seu equipamento de monitoramento HDMI. Por exemplo, alguns 
receptores AV de home theaters exigem que o som surround seja mapeado para canais 
específicos. Caso esteja trabalhando em um projeto que usa uma ordem de canais de som 
surround diferente, como a ordem SMPTE, você pode marcar a caixa de verificação “Use 5.1 
surround channel ordering” para garantir a compatibilidade com o seu receptor AV HDMI.

Ativa a opção “Use 5.1 surround channel ordering” para garantir a 
compatibilidade com outros equipamentos de monitoramento HDMI.

AES/EBU
Use os deslizadores para ajustar o nível “Ref”, ou ganho para as entradas e saídas de áudio 
AES/EBU. Pressione o ícone de restauração para redefinir o ganho como 0 dB.

Arraste o deslizador “Output Level” para controlar o nível da sua saída de áudio digital AES/EBU.

Analog Audio Input Levels
Channel 1/Channel 2

Essas configurações ajustam o ganho para as entradas de áudio analógico durante  
a captura. Clique no ícone de link para ajustá-los simultaneamente.

Use HiFi Audio Levels

Os conectores XLR profissionais são padrão nos modelos UltraStudio e DeckLink. 
Caso deseje conectar equipamentos de áudio de uso doméstico aos conectores XLR, 
certifique-se de marcar a caixa de verificação “Use HiFi audio levels”, pois os níveis de 
áudio de equipamentos profissionais e domésticos são diferentes. Você também 
precisará usar um adaptador RCA para XLR.

Ajuste os deslizadores dos canais de entrada para controlar os níveis de entrada de áudio analógico. 
Marque a opção “Use HiFi audio levels” se estiver utilizando equipamentos de áudio domésticos.

Analog Audio Output Levels
Channel 1/Channel 2

Essas configurações ajustam a intensidade do sinal de áudio, ou ganho, para as saídas 
de áudio analógico durante a reprodução de vídeo. Clique no ícone de link para 
ajustá-las simultaneamente.
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Ícone de Restauração
Ao ajustar os deslizadores, pode ser que você queira cancelar suas alterações. O ícone de 
restauração é uma seta circular localizada à direita da barra de títulos de cada configuração. 
Pressione o ícone de restauração em cada configuração para redefinir os controles de ganho 
para 0 dB.

Configurações de Conversões

Input Conversion
Esta configuração habilita a conversão ascendente e descendente em tempo real durante a 
captura. Selecione a conversão desejada no menu suspenso “Input Conversion”.

A conversão da entrada resulta em um atraso de até 2 quadros, então você precisará ajustar  
o deslocamento do seu código de tempo do seu software de edição para garantir a precisão.

Display As 

Selecione como deseja exibir o seu vídeo convertido. Dependendo da proporção de 
tela original do seu vídeo de entrada, você pode selecionar letterbox, anamórfico, 
corte central, pillarbox, 16:9 zoom ou 14:9 zoom.

Output Conversion
Esta configuração habilita a conversão ascendente e descendente em tempo real durante a 
reprodução. Selecione a conversão desejada no menu suspenso.

A conversão da saída resulta em um atraso de até 2 quadros, então você precisará ajustar  
o deslocamento do código de tempo do seu software de edição para garantir a precisão.

Convert Analog Outputs

Marque esta caixa para realizar sua conversão também nas saídas de vídeo analógico.

Display As

Selecione como deseja exibir o seu vídeo convertido. Dependendo da proporção de 
tela original do seu vídeo, você pode selecionar letterbox, anamórfico, corte central, 
pillarbox, 16:9 zoom ou 14:9 zoom. 

Para definir suas configurações de conversão ascendente ou descendente, selecione sua 
conversão de entrada ou saída no respectivo menu suspenso e selecione a proporção 
de tela desejada. Lembre-se de clicar em “Save” para aplicar suas configurações.

734Blackmagic Desktop Video Setup



A tabela abaixo mostra as opções de proporção de tela disponíveis durante as conversões.

Conversão  
Descendente

Imagem  
de Origem

Imagem  
Convertida

Letterbox
Redimensiona a imagem HD 16:9 para 
SD 4:3, com tarjas pretas nas partes 
superior e inferior.

Anamorphic
Encolhe a imagem HD 16:9 
horizontalmente em um quadro SD 4:3.

Center Cut

Esta configuração recorta um quadro 
SD 4:3 a partir de uma imagem HD 16:9. 
Esta configuração de proporção de tela 
descarta um trecho de cada lateral da 
imagem 16:9.

Pillarbox
Exibe uma imagem SD 4:3 dentro de 
um quadro HD 16:9. Tarjas pretas são 
exibidas nas laterais.

16:9 Zoom 
Redimensiona a imagem SD 4:3 para 
preencher o quadro HD 16:9. 

14:9 Zoom

Meio-termo entre 4:3 tarjas laterais  
e 16:9 zoom. Tarjas pretas mínimas  
com pequena perda nas partes  
superior e inferior.

About

Driver
A página “About” do Blackmagic Desktop Video Setup fornece informações sobre a versão 
atual do driver e a data da última atualização do dispositivo.

DICA  Você pode gerar um relatório de status clicando no botão “Create”, que permite 
salvar um arquivo contendo informações técnicas, como o formato de vídeo detectado 
na sua entrada e saída de referência, espaço de cor, amostragem de cor e 
profundidade de bits, informações sobre o driver, sistema operacional e informações 
sobre a máquina. Este relatório pode ser útil caso você precise entrar em contato com 
a nossa equipe de suporte técnico. O arquivo gerado é bem pequeno, portanto pode 
ser enviado por email facilmente.

Product Notes
Alterar o nome do seu equipamento Blackmagic Design permite identificar cada unidade no 
software Desktop Video Setup e acompanhar onde e como ela está sendo utilizada. Isso é útil 
se você tiver o mesmo dispositivo em vários locais em uma rede. Além disso, pode ser útil 
nomear as diferentes unidades de acordo com os seus propósitos, por exemplo: Suíte de 
Edição 2, Suíte de Colorização 1, etc.
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Quando você digita um nome para a sua unidade no campo de rotulagem, ele é salvo na 
página inicial do Blackmagic Desktop Video Setup e exibido abaixo da imagem do dispositivo.

Também é possível inserir informações importantes que você pode querer consultar mais tarde, 
como o número de série da unidade, local e data de compra da unidade, bem como os dados 
de contato do vendedor.

A aba “About” fornece informações úteis, como versão do driver, manual 
do usuário e notas de lançamento. Você também pode gerar um relatório 
de status e inserir anotações específicas para o seu dispositivo.

Usando o Painel Frontal 
do UltraStudio 4K Mini
No UltraStudio 4K Mini, a maioria das configurações que podem ser alteradas no utilitário Desktop 
Video Setup também está disponível através do menu LCD no painel frontal. Para navegar pelas 
configurações, pressione o botão “Menu” e, em seguida, navegue pelas opções usando o seletor 
giratório. Para entrar nos submenus e confirmar uma configuração, pressione o botão “Set”.

Para sair do menu, siga pressionando o botão “Menu” para recuar passos até retornar ao  
menu principal.

DICA  Você também pode navegar diretamente para as configurações de vídeo ou 
áudio pressionando os botões “Video” ou “Audio”. Isso permite que você vá 
diretamente para as configurações relevantes, sem percorrer a lista de configurações, 
economizando tempo.

Audio Meters

VU (-18dBFS)

VU (-20dBFS)

PPM (-18dBFS)

PPM (-20dBFS)

Use o menu LCD no painel frontal do UltraStudio 4K Mini para alterar configurações.
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Configurações de Áudio
O UltraStudio 4K Mini inclui configurações de áudio adicionais no menu LCD. Essas 
configurações permitem alterar os tipos de medidores de áudio exibidos no LCD durante  
a captura e reprodução. Os dois tipos de medidores de áudio são VU e PPM.

VU

O medidor VU, ou o medidor de unidades de volume, calcula a média de picos 
máximos e mínimos no seu sinal de áudio. Se você estiver usando medição VU, ajuste 
os níveis de saída na origem de modo que o pico do medidor ocorra em 0 dB no 
medidor de áudio. Isto maximiza a proporção sinal/ruído e garante que seu áudio 
possua a mais alta qualidade. Se seus picos de áudio ocorrerem acima de 0 dB, existe 
um alto risco de distorção sonora. Caso você esteja usando as entradas de áudio 
analógico do UltraStudio 4K Mini, os níveis de entrada podem ser ajustados no menu 
LCD ou no utilitário de configuração.

PPM

Os medidores PPM, ou medidores de programa de pico, exibem um recurso de 
retenção de pico que permanece visível por uma curta duração de tempo para que 
você possa visualizar nitidamente os níveis máximos atingidos.

Os medidores VU e PPM podem ser configurados para usar os níveis de referência de 
- 18 dB ou - 20 dB, assim você pode monitorar seu áudio para atender padrões de 
transmissão internacionais diferentes.

Compartimento para Cartão SD
O painel frontal do UltraStudio 4K Mini também possui um compartimento de cartão SD que lê 
e grava arquivos quando a unidade está conectada a um computador Mac ou Windows. Este 
compartimento pode ser usado como um leitor ou gravador de cartão SD comum e é 
detectado pelo seu computador como outro drive. Isso significa que você pode rapidamente 
importar clipes do cartão SD da sua câmera ou configurar o Media Express para capturar um 
clipe para uma mídia portátil.

Teranex Mini Smart Panel 

Encaixando um Teranex Mini Smart Panel
O Blackmagic UltraStudio HD Mini é uma solução compacta de captura e reprodução que 
compartilha um fator de forma semelhante a outros equipamentos Blackmagic, como 
conversores Teranex Mini e decks de gravação HyperDeck Studio Mini. Estes produtos foram 
desenvolvidos para ser portáteis e modulares, assim você pode levá-los em locação, montá-los 
na sua mesa ou encaixá-los em uma Teranex Mini Rack Shelf, que permite montar o seu 
dispositivo em um rack.

Encaixar um Teranex Mini Smart Panel opcional ao seu UltraStudio HD Mini permite que você 
faça a prévia de vídeo e áudio diretamente do painel frontal da unidade durante a reprodução 
e captura. 

O LCD integrado ao Teranex Mini Smart Panel exibe a imagem de entrada, bem como 
medidores de áudio, que permitem fazer a prévia dos seus níveis de áudio.
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Os painéis são substituíveis em funcionamento, assim você não precisa desligar o seu 
Blackmagic UltraStudio HD Mini durante a instalação.

1	 Remova os dois parafusos M3 de cada lado do painel frontal básico do seu Blackmagic 
UltraStudio HD Mini usando uma chave de fenda Pozidriv 2 e retire cuidadosamente o 
painel da parte frontal da sua unidade.

2	 Dentro do painel básico, você observará um pequeno tubo de plástico transparente 
fixado no canto inferior. Este tubo direciona a luz do LED dentro da unidade para 
iluminar o indicador de status no painel básico. Este tubo deve permanecer fixado ao 
painel frontal básico.

DICA  Caso reencaixe o painel frontal básico, certifique-se de que o tubo de 
luz esteja alinhado com o vão na frente da unidade.

3	 Alinhe o conector na parte traseira do Teranex Mini Smart Panel com o conector 
correspondente na frente do seu UltraStudio HD Mini e empurre o Smart Panel 
cuidadosamente em direção à unidade até que os conectores estejam encaixados 
firmemente. O Teranex Mini Smart Panel deve se encaixar firmemente na frente do  
seu UltraStudio HD Mini.

4	 Reinsira os parafusos M3 do painel original.

1

2

SET

VIDEO

MENU

AUDIO

Ao instalar o Teranex Mini Smart Panel no seu Blackmagic UltraStudio 
HD Mini, segurar o painel com seus dedos e polegar alinhados com 
o conector traseiro do painel ajudará a colocá-lo no lugar.

Se seu UltraStudio HD Mini for instalado em uma Teranex Mini Rack Shelf, você precisará 
remover a unidade da prateleira do rack para acessar os parafusos do painel frontal. 

Consulte a seção 'Teranex Mini Rack Shelf' para mais informações.

O painel básico original é bastante resistente, então, caso queira montar seu Blackmagic 
UltraStudio HD Mini na parte traseira de um sistema de rack com muitos cabos ou muita 
atividade, você pode sempre reinstalá-lo.
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Recursos do Smart Panel

Tela LCD
A tela inicial é o primeiro recurso que você encontrará na tela LCD do seu Teranex Mini Smart 
Panel. A tela inicial mostra informações importantes, incluindo:

Teranex Mini Rack Shelf
Ao utilizar o Blackmagic UltraStudio HD Mini com outros equipamentos, como Blackmagic 
ATEM Television Studio HD ou conversores Blackmagic Teranex Mini, você pode usar a 
Teranex Mini Rack Shelf para instalar suas unidades em um rack broadcast ou um case rígido. 
Até três unidades do tamanho do Teranex Mini podem ser encaixadas perfeitamente em cada 
Teranex Mini Rack Shelf de 1 U. 

O UltraStudio HD Mini pode ser instalado na prateleira de rack removendo os pés 
emborrachados da unidade e parafusando cada unidade na base da prateleira usando os 
orifícios de montagem na parte inferior.

UltraStudio HD Mini

A Teranex Mini Rack Shelf é fornecida com dois painéis vazios originais, que podem ser usados 
para preencher lacunas caso você não precise instalar unidades adicionais.

Para mais informações, consulte o site da Blackmagic Design em www.blackmagicdesign.com/br

Buffer – O número de quadros que pode 
ser armazenado no dispositivo durante a 
captura ou número de quadros armazenados 
no dispositivo durante a reprodução.

Fonte – O tipo de 
fonte de entrada de 
vídeo. SDI, YCbCr 
ou NTSC/PAL.

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Monitor de vídeo – Exibe a fonte 
da entrada de vídeo conectada 
ao UltraStudio HD Mini.

Medidores de áudio – 
Exibem os níveis de áudio 
da fonte de vídeo conectada 
ao UltraStudio HD Mini.

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Formato de vídeo – O 
formato de vídeo sendo 
capturado ou reproduzido.
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DaVinci Resolve

Gradação ao Vivo com DaVinci Resolve
O Desktop Video 10 permite captura e reprodução simultâneas em equipamentos 4K e 8K da 
Blackmagic Design. Isso é ótimo para usuários que desejam usar o recurso de gradação ao 
vivo dentro do DaVinci Resolve, pois isso significa que você não precisa de dois dispositivos 
separados para entrada e saída.

Ao usar a gradação ao vivo no set, basta conectar a saída da câmera à entrada do seu 
dispositivo Blackmagic Design. Em seguida, conecte a saída do dispositivo a um monitor de  
set para avaliação e visualização da gradação.

Configuração
1	 Inicie o DaVinci Resolve. A partir do menu de preferências, selecione a aba “E/S de 

Vídeo e Áudio” e selecione seu dispositivo na opção “Para Resolve Live”. Salve suas 
preferências e reinicie o DaVinci Resolve para aplicar suas alterações.

2	 Comece um projeto e abra a janela “Definições de Projeto”. A partir da aba 
“Configurações Master”, configure a resolução e a taxa de quadros da linha de tempo 
para combinar com a sua câmera.

3	 Acesse a aba “Captura e Reprodução” e selecione seu formato desejado a partir do 
menu “Captura e reprodução de vídeo”.

Selecione seu formato a partir do menu “Captura e reprodução de vídeo”.

4	 Vá até a página “Edição” e selecione Arquivo > Nova linha de tempo.

5	 A partir da página “Cor”, clique no menu “Cor” e selecione Resolve Live > On. Você 
observará o vídeo ao vivo dentro do visualizador e um botão vermelho “Resolve Live” 
brilhante aparecerá acima do vídeo.
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Usando Resolve Live
1	 No modo Resolve Live, o ícone de floco de neve congela o quadro do vídeo de entrada 

atual, assim você pode fazer a gradação sem a distração do movimento das filmagens. 

2	 Quando estiver satisfeito com um tratamento, clicando no botão “Fotograma”  
(ícone da câmera) você salva uma captura de tela da imagem estática mostrada no 
visualizador, o valor do código de tempo de entrada e a sua gradação na linha de 
tempo. As capturas de tela são basicamente clipes com um único quadro. Uma vez que 
você obteve sua captura de tela, pressione o ícone de floco de neve novamente para 
continuar a reprodução até encontrar o próximo plano de imagem que deseja colorizar.

DICA  Consulte o manual DaVinci Resolve para obter mais informações sobre o 
Resolve Live.

Editando com o DaVinci Resolve
O DaVinci Resolve possui uma interface fácil de usar que inclui todas as ferramentas necessárias 
para editar e finalizar projetos. Se você usa o mouse para arrastar e soltar clipes, ou o teclado 
para edição de precisão, o DaVinci Resolve inclui todas as funcionalidades que os editores 
profissionais exigem.

Configuração
1	 Inicie o DaVinci Resolve. No menu de preferências, selecione a aba “E/S de Vídeo e Áudio” 

e selecione seu equipamento Blackmagic Design na opção “Para captura e reprodução”. 
Salve suas preferências e reinicie o DaVinci Resolve para aplicar suas alterações.

2	 Carregue um projeto, abra “Definições de Projeto” no menu “Arquivo” e, sob 
“Configurações Master”, configure “Resolução da linha de tempo”, “Taxa de quadro da 
linha de tempo” e “Taxa de quadro de reprodução”.

3	 Na seção de monitoramento de vídeo, configure o seu formato de vídeo. O Blackmagic 
Desktop Video Setup irá alterar automaticamente para o formato de vídeo que você 
escolher para a saída do seu dispositivo de vídeo Blackmagic Design.

4	 Clique no botão “Salvar” para salvar as alterações e fechar a janela de configurações 
do projeto.

Use a janela “Definições de Projeto” para definir o formato da  
linha de tempo e as configurações de monitoramento de vídeo.

741DaVinci Resolve



Edição
1	 Use o navegador de armazenamento de mídia na página “Mídias” para carregar seus 

clipes no pool de mídia.

2	 Na página de edição, selecione Arquivo > Nova linha de tempo, dê uma nome à sua 
linha de tempo e clique no botão “Criar”.

3	 Agora você pode arrastar um clipe do pool de mídia para o visualizador de origem no 
lado esquerdo.

4	 Você pode definir os pontos de entrada e saída em clipes de origem usando as teclas  
I e O e arrastando o cursor de reprodução na barra abaixo da janela do visualizador.

5	 Para editar o clipe na linha de tempo, basta arrastar e soltar o clipe do visualizador de 
origem para a linha de tempo.

DICA  Consulte o manual DaVinci Resolve para mais informações sobre como editar 
com DaVinci Resolve.

Usando o seu 
Software de Terceiros Favorito 

Adobe After Effects CC

After Effects CC.

Como Pré-Visualizar Vídeo
Para exibir sua composição em tempo real por meio do seu dispositivo Blackmagic Design,  
vá até Preferências > Visualização de Vídeo. A opção “Ativar Mercury Transmit” precisa estar 
marcada para utilizar o seu dispositivo Blackmagic Design com o After Effects CC. Sob 
“Dispositivo de Vídeo”, selecione Blackmagic Playback. Agora você pode usar um monitor 
broadcast para visualizar suas composições After Effects no espaço de cores de vídeo.
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Preferências “Visualização de Vídeo”.

O seu dispositivo Blackmagic Design também pode retornar tamanhos de quadro não 
suportados ou não convencionais. Vá até Preferências > Visualização de Vídeo e clique no 
botão “Configurar” ao lado de “Blackmagic Playback”. A janela para a seleção do dispositivo 
Blackmagic será exibida. Você pode redimensionar sua imagem para o padrão de vídeo mais 
próximo suportado pelo seu dispositivo. Por exemplo, se você estiver usando o UltraStudio 4K 
e sua composição After Effects estiver configurada como 2048 x 1152, uma redução transmitirá 
a imagem em DCI 2K e um aumento transmitirá a imagem em Ultra HD.

Renderização
Quando você tiver concluído sua composição, você pode renderizar uma sequência de 
imagens DPX ou qualquer um dos seguintes codecs:

Opções de renderização nas “Configurações do Modulo de Saída”.
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Codecs QuickTime no Mac OS

�� Blackmagic RGB 10 bit (sem compactação)

�� Apple Uncompressed YUV 10 bit 4:2:2

�� Apple Uncompressed YUV 8 bit 4:2:2

�� Apple Photo - JPEG (compactado)

�� Apple DV - NTSC (compactado)

�� Apple DV - PAL (compactado)

Outros codecs, incluindo ProRes e DVCPRO HD, estarão disponíveis caso você tenha  
o Final Cut Pro instalado.

Codecs AVI no Windows

�� Blackmagic 10 bit 4:4:4 (sem compactação)

�� Blackmagic 10 bit 4:2:2 (sem compactação)

�� Blackmagic HD 8 bit 4:2:2 (sem compactação)

�� Blackmagic SD 8 bit 4:2:2 (sem compactação)

�� Blackmagic 8 bit MJPEG (sem compactação)

Outros codecs, incluindo DVCPRO HD e DVCPRO50, estarão disponíveis caso você tenho  
o Premiere Pro CC instalado.

Codecs QuickTime no Windows

�� Blackmagic RGB 10 bit (sem compactação)

�� Blackmagic 10 bit (sem compactação)

�� Blackmagic 8 bit (sem compactação)

�� Apple Photo-JPEG (compactado)

�� Apple DV - NTSC (compactado)

�� Apple DV - PAL (compactado)

Adobe Photoshop CC

Photoshop CC.
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Como Importar e Exportar Quadros de Vídeo

Como importar uma imagem para o Photoshop CC:

1	 Selecione File > Import > Blackmagic Image Import.

2	 Selecione o formato do vídeo de entrada, profundidade de bits e clique para 
importar a imagem.

Captação da imagem.

Como exportar uma imagem a partir do Photoshop CC:

1	 Selecione File > Export > Blackmagic Image Export.

2	 Selecione formato do vídeo de saída e clique para exportar a imagem.

Exportação da imagem.

Depois de definir as opções de importação ou exportação, as importações e exportações 
subsequentes não exibirão a janela de configurações. No entanto, você ainda pode alterar 
suas configurações mantendo pressionada a tecla Option [Mac] ou Ctrl [Windows] ao selecionar 
importação ou exportação.

Adobe Premiere Pro CC

Premiere Pro CC.
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Configurando um Projeto Blackmagic Design
1	 Abra o Premiere Pro e clique em “Novo projeto”. Digite um nome e selecione onde 

deseja salvar o arquivo de projeto.

2	 Caso sua placa de vídeo seja compatível com o Mercury Playback Engine do Premiere 
Pro CC, a opção de renderização estará disponível e você deve alterar para a 
aceleração Mercury Playback Engine GPU.

3	 No menu suspenso “Formato de Captura”, selecione “Blackmagic Capture”. Clique 
no botão “Configurações” [Mac] ou “Propriedades” [Windows] para definir as 
configurações de captura de vídeo e áudio. Selecione o padrão e o formato de vídeo. 
Clique em “Ok” para retornar à janela “Novo projeto”.

4	 Clique na aba “Discos de Trabalho” para definir os locais de armazenamento para 
o vídeo, áudio e pré-visualizações de vídeo e áudio. Click em “Ok” e o seu novo 
projeto abrirá.

5	 Agora verifique se o áudio padrão do sistema não está configurado como Blackmagic 
Desktop Video.

No Mac OS, abra "Preferências do Sistema”, clique na opção “Som”, na aba “Saída”  
e certifique-se de que o seu dispositivo Blackmagic não esteja selecionado. Na aba 
“Entrada”, selecione sua entrada de microfone, certificando-se de que o seu produto 
Blackmagic não esteja selecionado.

No Windows, vá até a barra de tarefas e clique com botão direito do mouse no ícone 
de alto-falante para abrir as configurações de som. Clique na aba “Reprodução” e 
configure seu PC para usar a placa de som onboard ou um dispositivo de áudio que 
não seja o seu dispositivo Blackmagic Design. Clique na aba “Gravação” e configure  
o computador para usar um dispositivo de gravação que não seja o seu dispositivo 
Blackmagic Design.

6	 No Adobe Premiere Pro, clique no menu “Preferências” e selecione “Hardware de áudio” 
Configure “Entrada padrão” como “Saída Integrada” usando o menu suspenso.  
Em “Mapeamento de saída”, mapeie a saída para “Áudio da área de trabalho da Adobe”.

Ao configurar as preferências de hardware de áudio do Adobe 
Premiere, certifique-se que as configurações “Saída padrão”  
e Mapeamento de saída” estão definidas como “Saída Integrada”.
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7	 No menu “Reprodução”, selecione “Reprodução Blackmagic” no menu suspenso 
“Dispositivo de áudio” e marque a caixa “Reprodução Blackmagic” sob “Dispositivo  
de vídeo”. Pressione “Ok”.

No Adobe Premiere Pro, configure o dispositivo de reprodução de áudio 
como “Reprodução Blackmagic” e marque a caixa de verificação “Reprodução 
Blackmagic” nas configurações de dispositivo de vídeo. 

8	 Para criar uma nova sequência, clique em Arquivo > Novo > Sequência. Selecione  
a predefinição desejada, digite um nome para a sequência e clique em “Ok”.

Criando uma nova sequência com as predefinições Blackmagic Design.
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Controle de Dispositivos
Vários modelos de captura e reprodução Blackmagic Design incluem RS-422 para controlar 
decks. Clique em Preferências > Controle de Dispositivos e verifique se o controle de 
dispositivos Blackmagic foi selecionado no menu “Dispositivos”. Clique em “Ok”.

Reprodução
Mesmo que você trabalhe com tamanhos de quadro não convencionais ou não suportados, 
ainda é possível fazer a saída corretamente a partir do seu dispositivo Blackmagic Design.  
Vá até Preferências > Reprodução e clique no botão “Configurar” ao lado de “Blackmagic 
Playback”. A janela de seleção de dispositivo Blackmagic será exibida. Você pode dimensionar 
sua imagem para o padrão de vídeo mais próximo suportado pelo seu dispositivo. Por exemplo, 
se você estiver usando o UltraStudio 4K e sua sequência Premiere estiver definida para uma 
resolução de 3996 x 2160, a redução do tamanho fará a saída em Ultra HD, enquanto o 
aumento do tamanho fará a saída em DCI 4K.

Selecione uma opção para transmitir tamanhos de quadro não suportados.

Caso seu dispositivo Desktop Video suporte HDR, você também pode definir a gama de cores 
e a função de transferência para projetos HDR. Isso inclui HLG e PQ para Rec 2020. A 
configuração de exibição da masterização HDR deve ser definida no máximo de nits que o seu 
monitor ou televisor é capaz de exibir.

Captura

Como definir preferências de captura: 

Arquivo > Capturar [F5] 

Digite o nome da fita e o nome do clipe.
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Configure a sua captura e controle de dispositivo na janela de captura.

Para capturar imediatamente, ou capturar de um dispositivo não controlável, clique no botão  
de gravação vermelho [G].

Caso deseje registrar o clipe usando um controlador de deck RS-422, configure os pontos de 
entrada e saída usando os botões “Definir entrada” e “Definir saída”, ou digite o timecode 
manualmente e clique em “Registrar clipe”. Insira um nome para o clipe e pressione “Ok”. O 
clipe vazio aparecerá na janela “Projeto”. Repita este processo até registrar todos os clipes que 
você capturar em lote. 

Em seguida, selecione: Arquivo > Captura em Lote [F6]. Para definir alças nos clipes, habilite a 
opção para capturar com alças e digite o número de quadros adicionais que deseja inserir no 
início e no fim de cada clipe e clique em “Ok”. Será solicitado que você insira sua fita. Clique 
em “Ok” e os seus clipes serão capturados.

Exportar para Fita 
Caso deseje editar sua linha de tempo para um deck externo, você pode usar o recurso  
“Editar para fita” do Premiere Pro. Escolha entre dois tipos de exportação: “Inserir” e “Montar”. 
A edição de inserção requer um código de tempo ininterrupto pela duração do projeto que 
será gravado em fita, e também é uma ótima solução quando você deseja substituir um plano 
de imagem em uma fita existente. No modo de montagem, é preciso adicionar preto à fita até 
um ponto um pouco além do código de tempo inicial da sequência. Como o modo de 
montagem apaga a fita antes das cabeças de gravação, ele não deve ser usado quando já 
existir um projeto na fita após o ponto de saída da sua edição.

Use o recurso “Editar para fita” para exportar sua edição para um deck externo.
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DICA  Ao exportar para fita usando o modo de montagem, é recomendável adicionar pelo 
menos 30 segundos de preto ao fim da sua sequência. Isso ajuda os recursos de pós-
rolagem da fita e evita o aparecimento de mídias indesejadas logo após as suas imagens.

Como exportar para fita via controle de deck RS-422:

1	 Certifique-se que as preferências do Adobe Premiere Pro estejam configuradas 
corretamente, conforme descrito em ‘Configurando um Projeto Blackmagic Design’  
no início desta seção.

2	 Abra a janela “Editar para fita” no Premiere Pro e clique em Arquivo > Exportar > 
Fita (dispositivo serial). Clique em “Configurações do Gravador”, selecione “Captura 
Blackmagic” no menu suspenso e clique em “Configurações”. Selecione o padrão e o 
formato do seu vídeo, assim como as configurações de áudio. Clique em “Ok”. Caso 
o formato de captura não coincida com o formato de saída, o deck pode se confundir 
durante a pré-rolagem e o áudio pode não ser exportado.

3	 Agora, escolha o tipo de exportação selecionando “Montar” ou “Inserir” no menu 
suspenso, digite o timecode de entrada e clique em “Gravar”.

Ao editar para fita, o software aguarda no primeiro quadro do seu projeto para que o deck 
inicie a gravação em um código de tempo predeterminado. Caso o primeiro quadro do seu 
programa se repita ou se perca durante o processo de edição para fita, será preciso ajustar a 
configuração Reprodução > Dispositivo de vídeo > Deslocamento para ressincronizar o deck  
e o computador. Você deve precisar fazer isso apenas uma vez para cada combinação de deck 
e computador e a configuração correta será mantida.

Adobe Character Animator CC
Alguns dispositivos de captura e reprodução Desktop Video permitem conectar gráficos 
gerados pelo Adobe Character Animator CC a outros equipamentos de vídeo, como um 
monitor de confiança. Por exemplo, você pode querer usar a performance de um personagem 
virtual em uma edição de vídeo e monitorar a performance em tempo real.

Esta seção mostra como configurar as opções de saída no Adobe Character Animator CC. 

1	 No Adobe Character Animator, selecione Character Animator > Preferências > 
Saída ao vivo.

2	 Certifique-se que a opção “Ativar Mercury transmit e Syphon” esteja marcada.

3	 Certifique-se que a opção “Blackmagic Playback” esteja marcada. 

4	 Selecione “Configurar” ao lado de “Blackmagic Playback”.

5	 No menu suspenso “Modo de Saída”, selecione um dos modos abaixo:
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Reprodução
Transmite um diretamente do Adobe Character Animator CC sem nenhum chaveamento.

Chaveamento Interno
Esta opção permite que você sobreponha seu personagem animado sobre outra fonte de 
vídeo usando o chaveador interno do seu dispositivo Desktop Video. Por exemplo, o plano de 
fundo pode ser um vídeo de um local relevante para uma notícia e o personagem pode ser 
sobreposto para fornecer uma entrevista ao vivo. Outra opção seria sobrepor personagem ao 
conteúdo da transmissão e inseri-lo no canto inferior como um logotipo ou marca d'água, 
fornecendo reações ao conteúdo que está sendo transmitido.

Preenchimento/Chave
Caso deseje realizar um chaveamento usando um switcher externo, como um switcher ATEM, 
você pode configurar o modo de saída como preenchimento/chave. O sinal de preenchimento 
é o personagem animado e o sinal de chave é a máscara em escala de cinza que instrui o 
chaveador a tornar o espaço ao redor do personagem transparente. Dessa forma, o chaveador 
pode fazer a sobreposição do personagem por cima de um segundo plano.

Final Cut Pro X
Você pode usar a opção “A/V Output” no Final Cut Pro X para transmitir o seu vídeo através do 
dispositivo de vídeo Blackmagic Design. Se você estiver usando um dispositivo Desktop Video 
compatível com HDR, você também pode visualizar e editar vídeos HDR com uma ampla gama 
de cores em televisores e monitores compatíveis.

Final Cut Pro X.

Configurando o Final Cut Pro X
1	 Certifique-se de que você esteja executando o Final Cut Pro X 10.0.4 ou posterior com 

a versão mais recente do Mac OS.

2	 Inicie o Blackmagic Desktop Video Setup. Clique no menu suspenso “Video 
Standard” e configure o mesmo formato que será usado no seu projeto Final Cut 
Pro X. Por exemplo, 2160p29.97. O formato deve coincidir com o formato de vídeo 
dos seus clipes. A configuração do padrão de vídeo também determina o modo de 
monitoramento da saída de vídeo.

Configure o formato de saída para corresponder ao formato do seu projeto Final Cut Pro X.
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3	 Clique no menu suspenso “Pixel Format” e configure-o para combinar com um formato 
compatível com o seu televisor ou monitor externo. Por exemplo, se você estiver 
trabalhando com uma ampla gama de cores HDR, escolha “10-bit YUV 4:2:2” ou “10-bit 
RGB 4:4:4” dependendo dos requisitos de compatibilidade do seu monitor.

4	 Clique no menu suspenso “Gama de Cores” e selecione uma opção que corresponda 
à gama de cores utilizada no seu projeto. Caso esteja trabalhando em um projeto de 
definição padrão ou alta definição com uma faixa dinâmica padrão, selecione “Rec. 601/
Rec. 709”. Se você estiver usando um dispositivo Desktop Video compatível com HDR 
e esteja editando um projeto de alta faixa dinâmica ou 4K, selecione 'Rec. 2020”. Para 
projetos com alta faixa dinâmica 4K, selecione “Rec. 2020 HLG” ou “Rec. 2020 PQ”. 
Este também deve ser um formato que o seu televisor ou monitor seja capaz de exibir.

Agora que você definiu as configurações do display de saída usando o Desktop Video Setup, 
você pode criar um novo projeto no Final Cut Pro X.

Como criar um novo projeto:

1	 Inicie o Final Cut Pro X. Nas propriedades da biblioteca, você notará o nome de projeto 
sem título padrão. Clique no ícone de edição. Crie uma nova biblioteca em File > New 
> Library.

DICA  Após criar uma nova biblioteca, as propriedades da biblioteca no lado 
direito da tela serão ocultadas. Você pode habilitá-las clicando no ícone de 
claquete no canto superior esquerdo. Isto abrirá a barra lateral de bibliotecas.

2	 Selecione a nova biblioteca na barra lateral e clique no ícone de edição correspondente.

Uma janela de opções será exibida solicitando que você configure o espaço de cor 
para o seu projeto. Selecione “Standard” para um projeto SD ou HD que utilize uma 
gama de cores padrão. Caso pretenda criar um filme com uma ampla gama de cores 
HDR, selecione “Wide Gamut HDR”.

3	 Clique em “Change” para confirmar suas configurações.

4	 Crie um novo projeto clicando no nome da biblioteca na barra lateral e selecionando 
“New Project”. Digite um nome e escolha um evento para colocar o seu projeto. Caso 
ainda não tenha criado um, você pode escolher o evento padrão, que é nomeado com 
a data atual.

5	 Clique em “Use custom settings”. Ajuste o formato de vídeo, resolução e taxa para 
combinar com o padrão de vídeo e taxa de quadro configurados no Blackmagic 
Desktop Video Setup.

6	 Em “Rendering”, selecione o seu codec Apple ProRes preferido ou 4:2:2 de 10 bits sem 
compactação para um fluxo de trabalho sem compactação.
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7	 Caso o seu projeto seja HD padrão, você não precisa alterar o espaço de cor, já que 
o Final Cut Pro seleciona o espaço de cor HD Rec. 709 padrão para você. Se você 
estiver trabalhando em um projeto HDR com uma ampla gama de cores, selecione 
o espaço de cor PQ ou HLG de acordo com o que seu televisor ou monitor é capaz 
de exibir.

8	 Configure os canais de áudio para estéreo, ou selecione “Surround” para 6 canais de 
áudio. Configure a taxa de amostra de áudio para a taxa de televisão de 48 kHz.

9	 Clique em “Ok” para concluir a criação do seu novo projeto.

Se você tiver um monitor HDMI ou SDI externo conectado, precisará garantir que o seu 
novo projeto seja exibido corretamente.

Como configurar o display de saída no Final Cut Pro X:

1	 Vá até o menu Final Cut Pro, selecione “Preferences” e clique na aba “Playback”. 
Certifique-se de que a opção “Blackmagic” esteja selecionada na “A/V Output” e que 
o padrão de vídeo seja o mesmo do seu projeto. Feche as preferências.

2	 Na barra de menu, selecione “Window” e clique em “A/V Output” para habilitar a saída 
de vídeo através do seu dispositivo Blackmagic Design.

Como configurar a saída de áudio no Mac OS:

1	 Abra as “Preferências do Sistema” e clique no ícone de “Som”.

2	 Clique na aba “Saída” e selecione “Blackmagic Audio” para a saída de som.

DICA  Você também pode monitorar áudio através do seu dispositivo Desktop Video.

Reprodução
1	 Importe alguns clipes para o seu novo projeto.

2	 Agora você pode usar a linha de tempo do Final Cut Pro X no monitor do seu 
computador e pré-visualizar o víeo no monitor ou televisor conectado à saída do seu 
dispositivo de vídeo Blackmagic Design.

Capturando Vídeo e Áudio
Você pode usar o Blackmagic Media Express para captar vídeo e áudio com seu hardware de 
vídeo Blackmagic Design. Depois de ter capturado os clipes, você pode pode importá-los para 
o Final Cut Pro X para edição.

Ao capturar clipes com o Media Express, certifique-se que o formato de vídeo selecionado 
também seja suportado pelo Final Cut Pro X. Por exemplo, Apple ProRes 4444 XQ, ProRes 
4444, ProRes 422 HQ, ProRes 422, ProRes 422 LT ou 4:2:2 de 10 bits sem compactação.

Editando para Fitas
Após concluir um projeto no Final Cut Pro X, você pode renderizar o projeto para um arquivo 
de filme e, em seguida, usar o Blackmagic Media Express para masterizar o filme para fita com 
o seu dispositivo de vídeo Blackmagic Design.

1	 Selecione seus clipes a partir da linha de tempo do Final Cut Pro X.

2	 Vá até File > Share > Master Files e a janela “Master File” abrirá.

3	 Clique em “Settings” e selecione o codec de vídeo desejado no menu suspenso.
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4	 Clique em “Next...”, selecione um local para o seu filme e clique em “Save”.

5	 Abra o Media Express e importe o clipe que foi exportado pelo Final Cut Pro X.

6	 Consulte ‘Editando Arquivos de Vídeo e Áudio para Fita’ na seção seção ‘Blackmagic 
Media Express’ deste manual.

Avid Media Composer
O Avid Media Composer captura e reproduz áudio e vídeo até 4K com dispositivos de vídeo 
Blackmagic Design e é compatível com controle de deck RS-422. Os plug-ins Blackmagic para 
Media Composer são instalados automaticamente caso o Media Composer seja instalado antes 
do software Desktop Video.

Avid Media Composer.

Configuração
1	 Inicie o Media Composer e a caixa de diálogo “Select Project” será exibida.

2	 Selecione o seu perfil de usuário favorito caso tenha criado um anteriormente.

3	 Selecione um local privado, compartilhado ou externo para o seu projeto.

4	 Clique no botão “New Project”.

5	 Digite um nome para o projeto e configure opções como formato, espaço de cor e 
estereoscópico. Clique em “Ok”. As configurações espaço de cor e estereoscópico 
podem ser alteradas mais tarde na aba “Format” do projeto. 
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Digite um nome e ajuste as configurações do projeto.

6	 Dê um clique duplo no nome do projeto no caixa de diálogo “Select Project”.  
A interface do Media Composer será exibida, assim como a janela para o seu novo 
projeto. Você acaba de concluir a configuração do seu projeto.

Reprodução
Como um teste rápido para garantir que tudo esteja conectado corretamente, vá até o menu  
de ajuda, clique em “Read me” e selecione o Media Composer Editing Guide. Siga a seção 
"Importing Colors Bars and Other Test Patterns". Dê um clique duplo no arquivo importado para 
reproduzi-lo. Agora você deve ver a imagem tanto no monitor do computador quanto na saída 
do seu dispositivo Blackmagic Design.

Caso não esteja visualizando nenhum vídeo na saída do seu dispositivo Blackmagic Design, 
verifique as conexões novamente e certifique-se de que as configurações de saída estejam 
corretas no Blackmagic Desktop Video Setup, selecionando Tools > Hardware Setup no Media 
Composer. Certifique-se que o ícone de dispositivo acima da linha de tempo esteja habilitado.

OBSERVAÇÃO  Caso esteja usando um dispositivo de vídeo Blackmagic externo 
como o Blackmagic UltraStudio 4K, certifique-se de que ele esteja alimentado e 
conectado antes de iniciar o Media Composer.

Captura de Dispositivos Não Controláveis
Muitas fontes de vídeo, incluindo todos os tipos de câmeras e gravadores de disco modernos, 
assim como câmeras antigas e gravadores VHS, não possuem controle de dispositivo. 

Como capturar vídeo sem controle de deck:

1	 Selecione File > Input > Tape Capture para abrir a ferramenta de captura.

2	 Clique no botão de ativação de fonte para que o ícone do deck mostre o botão 
de satélite, um planeta Terra com o símbolo de positivo. Este símbolo indica que o 
controle de deck foi desativado.
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Configure a ferramenta de captura para capturar vídeo sem 
controle de deck clicando no botão de ativação de fonte.

3	 Selecione as trilhas das fontes de vídeo e áudio que deseja capturar. Elas são 
rotuladas como “V” e “A1”, “A2”, etc. Usando os menus suspensos abaixo, selecione 
Blackmagic tanto para vídeo quanto para áudio.

4	 Use o menu “Bin” para selecionar um ficheiro de destino na lista de ficheiros abertos.

5	 No menu de resolução rotulado como “Res”, escolha o codec que deseja usar para os 
seus clipes captados. Neste exemplo, selecione DNxHD175x para vídeo HD de 10 bits.

6	 Selecione o armazenamento de disco para o vídeo e o áudio captados. Use o botão 
de modo de drive único/duplo para escolher se o vídeo e o áudio serão armazenados 
juntos em uma única unidade ou em unidades separadas. Selecione as unidades para 
sua mídia capturada a partir do menu “Target Drives”.

7	 Clique no botão “Tape Name?” na parte inferior da janela para abrir a caixa de diálogo 
“Select Tape”. Adicione um nome para a fita ou selecione na lista caso já tenha usado 
essa fita anteriormente.

8	 Certifique-se de que sua fonte de vídeo e áudio esteja pronta ou reproduzindo e, em 
seguida, clique no botão de captura. O botão de captura piscará em vermelho durante 
a gravação. Clique no botão de captura  
novamente para finalizar a captura.
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Captura de Dispositivos Controláveis com UltraStudio, DeckLink e Teranex
Se você tiver um deck que se conecta via RS-422, você precisará ajustar as configurações do 
deck antes de realizar uma captura com controle de deck.

1	 Selecione File > Input > Tape Capture para abrir a ferramenta de captura. Configure o 
deck como “Remote”. Caso esteja usando um dispositivo de vídeo Blackmagic externo, 
certifique-se de que ele esteja alimentado e conectado antes de iniciar o Media 
Composer. 

2	 Na janela do seu projeto, clique na aba de configurações e dê um clique duplo em 
“Deck Configuration”.

3	 Na caixa de diálogo “Deck Configuration”, clique em “Add Channel” e, em seguida, 
configure o tipo de canal como “Direct” e a porta como “RS-422 Deck Control”. 
Clique em “Ok” e responda “No” à pergunta “‘Do you want to autoconfigure the 
channel now?”

4	 Clique em “Add Deck” e, em seguida, selecione a marca e o modelo do deck nos 
menus do dispositivo e configure a pré-rolagem desejada. Clique em “Ok” e depois 
em “Apply”.

5	 Na aba de configurações, dê um clique duplo em “Deck Preferences”.

6	 Se você pretende fazer edições para fita no modo de montagem, ative a opção de  
“Allow assemble edit and crash record for digital cut”. Caso a opção permaneça 
desativada, você poderá realizar edições apenas no modo de inserção. Clique em “Ok”.

DICA  Caso seu Media Composer apresente o erro “Failed to find coincidence 
point on tape”, você pode marcar a opção “Relax coincidence point detection” 
nas preferências de deck para continuar.

Nas preferências de deck, marque esta opção para 
desativar a detecção do ponto de coincidência.
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Como capturar com controle de deck em tempo real:

1	 Selecione File > Input > Tape Capture para abrir a ferramenta de captura. Caso um 
deck conectado seja reconhecido e contenha uma fita ou disco, será solicitado que 
você digite um nome de fita, ou você pode escolhê-lo na lista.

2	 O botão de ativação de fonte deve exibir um ícone de deck. Se o ícone do satélite 
estiver presente, clique no botão para habilitar o controle de deck e fazer com que o 
ícone de deck apareça. 

3	 O botão de modo de captura/registro deve exibir um ícone “Cap”. Caso esteja exibindo 
um ícone “Log”, clique no botão para alterar o modo de captura e ícone “Cap” aparecerá. 

4	 Caso a mensagem “No Deck” seja exibida na janela do código de tempo, ou um nome 
de deck aparecer em itálico abaixo, clique no menu suspenso e selecione “Check 
Decks”. Quando o controle de deck é restabelecido, o nome do deck aparecerá sem 
itálico. Agora, experimente controlar o deck com as teclas de atalho J, K e L padrão.

5	 Selecione Blackmagic como a entrada de vídeo e áudio. Selecione as trilhas das fontes 
de vídeo e áudio, ficheiro de destino, resolução, unidade de destino e nome da fita da 
mesma maneira que na seção “Captura de Dispositivos Não Controláveis” acima.

6	 Use a janela de controle de deck na ferramenta de captura para sinalizar a fita e 
começar a reproduzir.

7	 Clique no botão de captura. O botão de captura piscará em vermelho durante a 
gravação. Clique no botão de captura novamente para encerrar a captura.

Configure os botões de captura e seleção de fonte para usar controle de deck.  
Use a janela de controle de deck para sinalizar a fita e iniciar a reprodução.
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Captura em Lote com UltraStudio e DeckLink
Como registrar clipes para captura em lote:

1	 Selecione File > Input > Tape Capture para abrir a ferramenta de captura.

2	 Caso o deck esteja em modo satélite, clique no botão de seleção de fonte para 
alterá-lo para o modo deck. Clique no botão “Capture/Log” para que exiba o ícone de 
lápis “Log”.

3	 Configure entrada de vídeo e áudio, trilhas de fontes de vídeo e áudio, ficheiros de 
destino, resolução, unidade de destino e nome da fita da mesma maneira que na 
seção “Captura de Dispositivos Não Controláveis” acima.

4	 Use a janela “Deck Controller” ou as teclas de atalho J, K e L padrão para pausar, 
retroceder, avançar e localizar o vídeo que você deseja capturar.

5	 Clique no botão “Mark in/out” à esquerda do botão “Log”. O ícone alternará entre “in” e 
out”, portanto você só precisa clicar em um botão para marcar todos os seus pontos de 
entrada e saída e registrar o seu clipe. Isto pode ser mais prático do que usar botões 
de marcação de entrada e saída na janela “Deck Controller”. Como alternativa, utilize 
as teclas I e O no teclado para marcar os pontos de entrada e saída; e a tecla F4 para 
registrar o clipe.

Clique no botão “Mark in/out” ou use as teclas I e O no 
teclado para marcar os pontos de entrada e saída.

6	 Quando terminar de registrar seus clipes, feche a ferramenta de captura, abra o 
ficheiro de registro e selecione os clipes que deseja capturar.

7	 A partir do menu “Clip”, escolha captura em lote, selecione as opções desejadas na 
caixa de diálogo resultante e clique em “Ok”.
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Gravando em Fita com UltraStudio e DeckLink
Após capturar seus clipes, arrastar para a linha de tempo, editar e aplicar e renderizar efeitos, 
você provavelmente vai querer gravar o projeto concluído em fita.

1	 Dê um clique duplo na sua sequência para abri-la na janela da linha de tempo. 

2	 Selecione File > Output > Digital Cut para abrir a janela “Digital Cut Tool”.

3	 Configure “Output Mode” como “Real-Time” e profundidade de bits como “10-bit”. 
Marque “Entire Sequence” para gravar a sua sequência inteira; e configure “Deck 
Control” como “Remote”.

4	 Selecione “Insert Edit” ou “Assemble Edit” para edições precisas em uma fita listrada. 
Como alternativa, selecione “Crash Record” para uma maneira simples de gravar. Caso 
“Insert Edit” seja a única opção, vá até a aba de configurações do seu projeto, dê um 
clipe duplo em “Deck Preferences” e ative “Allow assemble edit & crash record for 
digital cut”.

5	 Caso um nome de deck seja exibido em itálico ou a mensagem “No Deck” seja 
exibida, clique no menu e selecione “Check Decks” até que o deck esteja listado sem 
itálico e o controle de deck seja restabelecido.

6	 Pressione o botão “Play Digital Cut” (ícone de triângulo vermelho) para gravar sua 
sequência em fita.

A janela “Digital Cut Tool” é usada para gravação em fita.
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Autodesk Smoke
O Autodesk Smoke reúne edição, composição e efeitos 3D em uma única área de trabalho.  
O Smoke captura e reproduz áudio e vídeo de alta definição e definição padrão com 
dispositivos de vídeo Blackmagic Design e também suporta controle de deck RS-422. 

Autodesk Smoke

Configurando um VTR
Antes de iniciar o Autodesk Smoke, você precisa usar um utilitário chamado Smoke Setup para 
selecionar o modelo do VTR na sua instalação e ajustar as configurações de temporização.

1	 Vá até Aplicativos > Autodesk > Smoke 2018 > Utilitários e abra Smoke Setup.

2	 Na aba “General”, certifique-se que os dispositivos de vídeo e áudio estejam 
configurados como “BMD”.

3	 Na aba “VTR”, habilite o modelo VTR e as temporizações que deseja utilizar com o 
Autodesk Smoke. Habilite as fileiras com NTSC ao vivo ou PAL ao vivo para ativar 
“Crash Record” ou “Live Output”.

4	 Clique em “Apply” e feche o Smoke Setup.

No utilitário Smoke Setup, certifique-se que os dispositivos 
de vídeo e áudio estejam configurados como BMD.
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Instruções Preliminares
1	 Inicie o Smoke e a janela “Project and User Settings” aparecerá. Escolha o seu projeto 

e usuário caso eles já tenham sido criados anteriormente. Caso contrário, crie um novo 
projeto e/ou usuário.

2	 Ajuste as configurações do projeto para corresponder às configurações de 
entrega, por exemplo, 1080HD. A maioria dessas configurações pode ser alterada 
posteriormente, durante a sua sessão.

3	 Escolha o seu formato intermediário, como ProRes 422 HQ, ou mesmo sem 
compressão, para a sua mídia gerada pelo projeto. Lembre-se de escolher um formato 
com o qual a sua mídia de armazenamento possa lidar.

4	 Clique no botão “Create”.

Configurando Dispositivos
É recomendável seguir os passos abaixo ao se preparar para uma sessão VTR.

1	 Conecte as saídas do seu VTR às entradas do seu dispositivo de captura e reprodução 
Blackmagic Design. Conecte as saídas do seu dispositivo de captura e reprodução 
Blackmagic Design às entradas do seu VTR.

2	 Conecte um cabo de controle de deck RS-422 da porta serial do seu VTR à porta de 
controle remoto do seu dispositivo de captura e reprodução Blackmagic Design. 

3	 Configure o seu VTR como remoto. 

4	 Conecte um gerador de sincronização à entrada de sincronização do VTR para garantir 
uma captura com precisão de quadros. 

Caso você tenha um dispositivo de áudio separado, um sinal de sincronização de áudio 
também precisa estar conectado.

Digite um nome e ajuste as configurações do seu projeto.
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Captura de Dispositivos Controláveis com UltraStudio e DeckLink
O Autodesk Smoke pode ser configurado para capturar de VTRs controláveis com controle de 
deck RS-422.

1	 Selecione uma pasta na biblioteca de mídia onde você quer que o clipe capturado 
seja criado.

2	 Selecione File > Capture from VTR. O módulo de captura VTR será exibido.

Certifique-se que os dispositivos de vídeo e áudio estejam 
configurados como “BMD” no utilitário Smoke Setup.

3	 Sinalize a fita para o quadro inicial do clipe que deseja capturar.

4	 Selecione os canais de vídeo e áudio que deseja gravar. Os botões ficarão vermelhos 
para indicar quais trilhas estão habilitadas.

As trilhas de vídeo e áudio ficam vermelhas quando  
habilitadas para captura pelo seu VTR.

5	 Insira os pontos de entrada e saída nos campos “In” e “Out”. 

6	 Clique em “Capture” para iniciar a captura. O campo “Timecode” ficará verde para 
indicar que a captura está em andamento.

7	 Finalize a captura a qualquer momento clicando em qualquer lugar da janela da pré-
visualização. O clipe será salvo automaticamente no local que você selecionou antes 
de inserir o módulo de entrada VTR.

Gravação em Fita com UltraStudio e DeckLink
Carregue um clipe no módulo de saída VTR e configure os pontos de entrada e saída para o 
clipe de saída. Caso necessário, você também pode habilitar as opções para deslocar o quadro 
inicial para saída e aplicar uma sobreposição no estilo letterbox.

1	 Selecione File > Output to VTR.

2	 Selecione o(s) clipe(s) para saída a partir da biblioteca de mídias. Você também pode 
selecionar uma pasta caso queira enviar seus conteúdos em uma única sessão.  
O módulo de saída VTR é exibido.
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Seu VTR pode ser selecionado na lista suspensa.

3	 Selecione o VTR na caixa do nome do dispositivo. A janela de pré-visualização exibe  
o vídeo da fita no VTR selecionado.

4	 Certifique-se de que os botões de trilha de vídeo e canais de áudio corretos estejam 
habilitados para que a trilha de vídeo e os canais de áudio correspondentes sejam 
enviados à fita.

5	 Habilite ou desabilite “All Audio” no menu “Clip Output”. Quando a opção “All Audio” 
estiver habilitada, todos os canais de áudio serão convertidos para o formato na sua 
fita, não apenas aqueles que você habilitou.

6	 Clique em “Preview” para assistir ao clipe antes de fazer a saída.

7	 Para fazer a saída do clipe selecionado a partir de qualquer quadro que não seja o 
primeiro, insira o código de tempo de início no campo “Start Offset”.

Os clipes selecionados para a saída aparecem 
em uma lista com seus status atuais.

8	 Selecione os pontos de entrada e saída para o clipe.

Selecione seus pontos de entrada e saída e, em seguida, 
selecione “Insert” no menu suspenso “Output”.

9	 Para fazer a saída do clipe para o VTR, selecione “Insert”. Os clipes selecionados 
serão enviados para a fita. Durante a saída, o status de cada clipe será atualizado para 
“Pending”, “Output” e, em seguida, “Done”.

10	 Sinalize para o código de tempo de entrada e, em seguida, selecione “Play” para 
verificar se a transferência foi realizada com sucesso.

11	 Quando terminar, clique em “Exit Output Clip” para fechar o módulo.
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Agendamento de Gravação e Saída Ao Vivo
O Autodesk Smoke permite que você capture um sinal de vídeo ao vivo ou faça o 
agendamento da gravação de um clipe usando um tablet e uma caneta ou um mouse para 
iniciar e interromper o processo de captura ou transferência do clipe. Quando você escolhe 
essa forma de captura, o Autodesk Smoke verifica o seu dispositivo de armazenamento de 
mídia Autodesk para determinar o espaço disponível, que varia dependendo do seu formato 
intermediário preferido.

Além disso, se você estiver usando um dispositivo que não seja compatível com controle 
remoto via RS-422, como uma câmera, videocassete ou qualquer outro dispositivo, use a 
opção “Live NTSC or PAL” para capturar e a opção “Live Video” para fazer a saída de clipes.

Selecione as linhas com NTSC ao vivo ou PAL ao vivo para 
habilitar agendamento de gravação ou saída ao vivo.

Como agendar a gravação de um sinal de vídeo ao vivo:

1	 Escolha a pasta da biblioteca de mídias onde deseja que o clipe capturado  
seja criado.

2	 Selecione File > Capture from VTR. O módulo de captura VTR será exibido.

3	 Na caixa do dispositivo VTR, selecione “‘Live NTSC” ou “Live PAL”. O sinal do vídeo de 
entrada ao vivo aparece na janela de pré-visualização.

4	 Selecione o modo “Start on Pen”. Finalize a captura usando “Stop on Pen” ou “Stop 
on Frames”. Tradicionalmente, o Autodesk Smoke era operado com um tablet e uma 
caneta, por esse motivo utiliza-se o termo “Start on Pen”.

Quando “Stop on Pen” é selecionado como o modo de parada da captura, os campos 
de ponto de saída e código de tempo de duração serão atualizados para mostrar o 
clipe mais longo possível que pode ser gravado no seu dispositivo de armazenamento 
Autodesk Media. A captura terminará quando você clicar em qualquer lugar da tela ou 
quando o armazenamento estiver preenchido.

5	 Insira o nome do clipe ou habilite as trilhas de vídeo e canais de áudio que 
deseja capturar.

6	 Certifique-se que você esteja recebendo o sinal de vídeo ao vivo.

7	 Pressione “Play” no dispositivo de vídeo.

8	 Selecione “Process” para iniciar a captura.

9	 Clique em qualquer lugar da tela para encerrar a captura no modo “Stop on Pen”. 
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Como fazer a saída de um sinal de vídeo ao vivo:

1	 Selecione File > Output to VTR.

2	 Selecione o(s) clipe(s) para transmissão na biblioteca de mídias. Você também 
pode selecionar uma pasta para enviar os seus conteúdos. O módulo de saída VTR 
é exibido.

Selecione “Live PAL” ou “Live NTSC” ao fazer a saída de um sinal de vídeo ao vivo.

3	 Na caixa do dispositivo VTR, selecione “‘Live NTSC” ou “Live PAL”.

A caixa “Start Mode” estará indisponível. Com a saída de vídeo ao vivo, é preciso usar 
a configuração padrão. Você pode usar “Stop on Pen” ou “Stop on Frames” para 
encerrar a transferência.

Use as configurações padrão para saída ao vivo.

4	 Configure as opções de saída. Por exemplo, insira o nome do clipe e habilite as trilhas 
de vídeo e os canais de áudio que deseja capturar. 

5	 No dispositivo que está recebendo o sinal, inicie a gravação ou tome qualquer ação 
necessária para habilitar a recepção do sinal do Autodesk Smoke.

6	 Selecione “Process” para iniciar a transmissão no Autodesk Smoke.

7	 Clique em qualquer lugar na tela para finalizar a transmissão no modo “Stop on Pen”.
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Blackmagic Media Express

O que é Blackmagic Media Express?
O software Blackmagic Media Express está incluído em todos os produtos UltraStudio, 
DeckLink e Intensity, além das linhas ATEM Switcher, Blackmagic Camera, H.264 Pro Recorder, 
Teranex Processor e Universal Videohub. O Media Express é uma ótima ferramenta quando 
você não precisa da complexidade dos programas NLE, mas simplesmente deseja capturar, 
reproduzir e enviar clipes para fita. 

Capturando Arquivos de Vídeo e Áudio

Configurando um Projeto
O Media Express detecta automaticamente o formato de vídeo de entrada e define o “formato 
de vídeo do projeto" para combinar. Caso deseje configurar o formato de vídeo do projeto 
manualmente:

1	 Vá até Media Express > Preferences no Mac; ou Edit > Preferences no Windows ou 
Linux. Selecione o formato de vídeo do projeto na lista suspensa na parte superior 
da janela de preferências. Você pode escolher entre uma variedade de formatos de 
captura com e sem compressão, ou até mesmo uma sequência de imagens DPX no 
menu suspenso “Capture File Format”. O vídeo será capturado no formato escolhido e 
salvo como um filme QuickTime. Você também pode optar por capturar uma fonte RGB 
usando um codec YUV ou vice-versa.

Use a janela de preferências para definir o formato de vídeo do projeto, o formato 
do arquivo capturado, o local de armazenamento e outras configurações.
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2	 Defina o local de armazenamento para o vídeo e o áudio capturados. Clique no botão 
“Browse” para apontar o software para uma pasta no seu computador.

3	 Escolha se deseja interromper a captura ou reprodução caso quadros descartados 
sejam detectados.

Os projetos de definição padrão usam proporção de tela 4:3, a menos que você habilite a caixa 
de seleção “‘Use anamorphic SD 16:9”. 

Os aplicativos normalmente interrompem a reprodução de vídeos caso você os coloque em 
segundo plano. Marque a caixa de seleção “Continue playback when in the background” caso 
queira que o Media Express continue reproduzindo vídeo mesmo que você abra outro aplicativo.

As opções na parte inferior da tela se referem a decks de fita com controle de deck RS-422 e 
incluem pré-rolagem e deslocamento de código de tempo.

Captura
Para capturar vídeo, basta conectar uma fonte de vídeo, esperar o Blackmagic Media Express 
detectar sua entrada e pressionar o botão “Capture”.

Insira uma descrição para o seu vídeo.

Ficheiros de 
clipes

Opções  
de captura

Controles  
de  

transporte

Obter  
captura  
de tela

Nome do projeto,  
formato e taxa  

de quadro

Indicador  
remoto

Registros 
em log

Pontos de 
entrada  
e saída

Medidores  
de áudio

Habilitar / 
desabilitar 
 canais de 

áudio

Lista de mídias Campo de busca
Timecode, miniaturas  

e favoritos Timecode do VTR / deck Previsualização de vídeo
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1	 Comece conectando sua fonte de vídeo a uma entrada do seu dispositivo 
Blackmagic Design. Inicie o Desktop Video Setup e verifique se a conexão de entrada 
é a mesma que a fonte de vídeo, por exemplo, SDI, HDMI, componente, etc.

2	 Abra o Media Express e clique na aba “Log and Capture”.

3	 Sua fonte de vídeo será exibida no painel de pré-visualização. Insira uma descrição no 
campo “Description”.

4	 Clique no botão “+” ao lado da descrição para adicioná-lo ao campo de nome 
automático. Clique no botão “+” ao lado de qualquer um dos outros campos que você 
deseja adicionar ao campo de nome.

ͽͽ Para incrementar o valor em cada um desses campos, clique no ícone de claquete 
correspondente. Como alternativa, digite diretamente em qualquer campo para 
personalizar seu nome e número.

ͽͽ O texto no campo de nome automático será aplicado ao(s) clipe(s) prestes a ser(em) 
capturado(s).

ͽͽ Para registrar o clipe como um favorito, clique no ícone de estrela ao lado do 
campo de nome.

ͽͽ Para que um aviso de confirmação de nome de clipe apareça antes de cada captura, 
clique no ícone “!” ao lado do campo de nome.

5	 Configure o número de canais de áudio a serem capturados.

Configure o número de canais de áudio a serem capturados.

6	 Clique no botão “Capture” para iniciar a gravação. Para interromper a captura e manter 
o clipe, clique no botão “Capture” novamente ou pressione a tecla Esc. Os clipes 
capturados são adicionados à lista de mídias no lado esquerdo do Media Express.

Clique no botão “Capture” para iniciar a captura.

Caso o formato da entrada de vídeo seja diferente do formato de vídeo do projeto, o Media 
Express irá detectá-lo automaticamente e solicitará que você salve o projeto atual e crie um novo.

O Blackmagic Media Express detectará automaticamente se você alterar o formato da saída de 
programa do seu switcher ATEM e oferecerá a opção de salvar e iniciar um novo projeto.
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Registrando Clipes

Certifique-se de que um cabo serial RS-422 esteja conectado entre o seu dispositivo de vídeo 
Blackmagic Design e o deck. 

Certifique-se de que a chave remoto/local do deck esteja definida como remoto. Use as teclas 
de atalho J, K e L padrão para pausar, retroceder e avançar.

�� Clique no botão “Mark in” para marcar o ponto de entrada; ou use a tecla de atalho I.

�� Clique no botão “Mark out” para marcar o ponto de saída; ou use a tecla de atalho O.

�� Clique no botão “Log Clip” para registrar o clipe; ou use a tecla de atalho P. Agora, 
a entrada deverá aparecer na lista de mídias com um X vermelho no seu ícone para 
indicar que a mídia está offline.

Captura em Lote

Depois de registrar um clipe, você pode clicar no botão “Clip” para capturar um único clipe.

Para capturar múltiplos clipes, continue registrando os clipes para captura em lote.

Selecione os clipes registrados na lista de mídias e realize uma das seguintes ações:

�� Clique no botão “Batch”.

�� Clique com o botão direito do mouse na seleção e escolha “Batch Capture”.

�� Vá até o menu “File” e selecione “Batch Capture”.

O Media Express irá capturar o clipe desde o código de tempo de entrada até o código de 
tempo de saída.

Captura DPX

Caso deseje capturar uma sequência de imagens DPX em vez de um arquivo de filme, abra as 
preferências do Media Express e configure “Capture file format” para “DPX 10-Bit RGB”.

�� Crie um projeto DPX definindo o formato do arquivo como DPX.

�� Capture.

Preferências de captura DPX.

Quando a captura for concluída, uma única miniatura aparecerá na lista de mídia, 
representando toda a sequência de quadros. A sequência de quadros DPX será armazenada 
em uma pasta própria no seu armazenamento de disco. O áudio será armazenado em um 
arquivo .wav na mesma pasta.

Por padrão, o software presume que as capturas DPX sejam provenientes de fontes YUV.  
Caso você esteja capturando a partir de uma fonte RGB, selecione “Capture from an 
RGB source”. 

Caso queira que os números de quadros DPX sejam baseados no código de tempo do vídeo 
capturado, ao invés de simplesmente começar do zero, habilite a opção “Use absolute frame 
numbering when capturing DPX”.

Caso não esteja realizando capturas DPX longas, é recomendável reduzir o número de zeros 
nos números de quadros, alterando a opção “When capturing DPX files, use (2-8) digit numbers 
in the frame count”.
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Captura 3D

Quando o Media Express é usado com um dispositivo de vídeo Blackmagic Design compatível 
com 3D de fluxo duplo, você pode criar clipes de vídeo 3D para o olho esquerdo e direito 
capturando dois fluxos de vídeo HD-SDI simultaneamente.

�� Crie um projeto 3D que coincida com a taxa de quadros da sua fonte de vídeo 3D de 
fluxo duplo.

�� Caso esteja captando a partir de uma fonte SDI, certifique-se que você tenha duas 
entradas de vídeo HD-SDI discretas para o dispositivo de vídeo Blackmagic.

�� Capture.

Selecione um formato de vídeo do projeto com “3D” no nome 
para capturar clipes de vídeo 3D estereoscópico de fluxo duplo.

Ao capturar e registrar 3D de fluxo duplo no Media Express, o nome do clipe será aplicado ao 
vídeo do olho esquerdo. O vídeo do olho direito será nomeado com o texto “_right”. Por 
exemplo, caso você nomeie o clipe estéreo como “Clipe 1”, o clipe do olho esquerdo se 
chamará “Clipe 1.mov” e o clipe do olho direito se chamará “Clipe 1_right.mov”.

A lista de mídias apresenta uma indicação chamativa de que o clipe capturado é um clipe 3D:

�� Na exibição em miniatura, os clipes do olho esquerdo e direito são conectados por um 
indicador 3D e apresentados como um único ícone grande.

�� Na visualização em lista de código de tempo, os clipes do olho esquerdo e direito são 
apresentados em duas linhas e ligados por um indicador 3D.

Na exibição em miniatura, os clipes do olho esquerdo 
e direito são conectados por um indicador 3D e 
apresentados como um único ícone grande.

771Blackmagic Media Express



Ficheiro  
de clipes

Favoritos Controles  
de  

transporte

Obter  
quadro  
estático

Nome do projeto,  
formato e taxa  

de quadro

Indicador  
remoto

Informações 
do clipe

Pontos de 
entrada  
e saída

Medidores  
de áudio

Habilitar / 
desabilitar 

 canais  
de áudio

Lista de mídias Campo de busca
Timecode, miniaturas  

e favoritos Timecode do VTR / deck Pré-visualização de vídeo

Reproduzindo Arquivos de Vídeo e Áudio

Reproduzindo clipes individuais ou múltiplos clipes
Para reproduzir um clipe individual, dê um clique duplo na lista de mídias. Alternativamente, 
selecione o clipe na lista de mídias e pressione a barra de espaço no seu teclado ou pressione 
o botão de reprodução nos controles de transporte.

Você pode usar os controles de transporte para reproduzir, parar, reproduzir 
em loop, saltar para o próximo clipe ou saltar para o clipe anterior.

Para reproduzir vários clipes, selecione os clipes na lista de mídias e, em seguida, pressione a 
barra de espaço no seu teclado ou o botão de reprodução nos controles de transporte.

Seu vídeo será reproduzido no painel de pré-visualização de vídeo do Media Express e em 
todas as saídas de vídeo do seu dispositivo de vídeo Blackmagic Design. Durante a 
reprodução, os canais de áudio que estão sendo monitorados podem ser ativados ou 
desativados através dos botões para habilitar/desabilitar trilhas.

Importando clipes
Após importar mídias para o Media Express, você pode reproduzir seus arquivos de vídeo e 
áudio das seguintes maneiras:

�� Dê um clique duplo em uma área vazia da lista de mídias, navegue até o local do seu 
arquivo e clique em “Open”.

�� Clique com o botão direito do mouse em uma área vazia da lista de mídias e selecione 
“Import Clip” no menu contextual.

�� Vá até o menu “File”, selecione “Import” e, em seguida, “Media Files”.
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Selecione o(s) clipe(s) de vídeo e áudio que deseja importar e pressione “Open”. Os clipes 
serão exibidos na área “Scratch” da lista de mídias. Caso tenha criado seus próprios ficheiros 
na lista de mídias, você pode arrastar os clipes para o ficheiro desejado.

Para importar diretamente para um ficheiro, clique com o botão direito do mouse dentro do 
ficheiro desejado e selecione “Import Clip” no menu contextual.

Se os arquivos que estão sendo importados não corresponderem à taxa de quadros e tamanho 
dos clipes existentes na lista de mídias, será solicitado que você crie um novo projeto e salve o 
projeto atual.

Caso os clipes importados não correspondam aos clipes 
existentes, será solicitado que você crie um novo projeto.

DICA  O Media Express também permite importar arquivos que contenham apenas 
áudio multicanal, gravados a 48 kHz nos formatos WAVE e AIFF sem compressão.

Outra maneira de importar mídias é usar um arquivo XML exportado de um NLE como Final Cut 
Pro 7 ou Final Cut Pro X. Acesse o menu “File”, selecione “Import” e, em seguida, o arquivo 
XML do Final Cut Pro 7 ou Final Cut Pro X. Abra o XML desejado e todos os ficheiros e mídias 
do projeto Final Cut Pro aparecerão na lista de mídias.

O Media Express também permite importar arquivos CMX EDL para capturar clipes em lote 
usando arquivos EDL de outros programas de vídeo. Vá até o menu “File”, selecione “Import” e, 
em seguida, CMX EDL. Selecione o EDL e abra o arquivo. 

Você pode importar mídias diretamente  
ou importar com um XML ou EDL.

As informações de registro serão exibidas na lista de mídias. Selecione os clipes registrados e 
realize uma captura em lote para importar os clipes do seu deck.
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Pesquisando Mídias

Exibição em miniatura
As miniaturas são a maneira mais intuitiva de exibir os seus clipes. Passe o mouse por cima da 
miniatura do clipe e, em seguida, clique no ícone de informações pop-up na parte inferior 
direita da miniatura. Clique na janela de informações para ocultá-la.

Clique no ícone de informações pop-up de uma  
miniatura para visualizar a janela de informações.

Exibição em lista
Você pode visualizar seus clipes em uma lista de códigos de tempo clicando no botão 
“Timecode List” no canto superior direito da lista de mídias. Use a barra de rolagem horizontal 
para visualizar todas as colunas de informações para os seus clipes.

Na lista de mídias, opte por visualizar seus clipes em miniatura ou como uma lista 
de códigos de tempo. Clique no botão “Favorites” para exibir apenas os seus clipes 
favoritos. Digite no campo de busca para encontrar os seus clipes favoritos.

Criando e usando ficheiros
Para criar um ficheiro, dê um clique duplo em um compartimento vazio da lista de mídias e 
selecione “Create Bin”. Crie um nome para o novo ficheiro.

Você pode movimentar os clipes arrastando ícones até o ficheiro desejado. Caso deseje que 
um clipe apareça em mais de um ficheiro, importe o mesmo clipe novamente clicando no 
ficheiro com botão direito do mouse e escolhendo “Import Clip”.

Por padrão, os clipes registrados são exibidos na seção “Scratch”. Caso queira registrar clipes 
e fazer com que eles sejam exibidos em um novo ficheiro, clique no novo ficheiro com o botão 
direito do mouse e selecione “Select as Log Bin”.

Criando e usando favoritos
Na aba “Log and Capture”, clique no ícone de estrela ao lado do campo de nome para marcar 
um clipe como favorito.

Na aba “Playback”, clicar no ícone de estrela marcará o clipe como favorito caso esteja 
selecionado na lista de mídias. Clicar no ícone de estrela novamente irá desmarcar o clipe 
como favorito.
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Clipes marcados como favoritos serão destacados com uma estrela amarela tanto nos modos 
de exibição em miniatura quanto no modo código de tempo.

Depois de ter marcado clipes como favoritos, clique no botão “Show only favorites” na parte 
superior da lista de mídias. O ícone de estrela se tornará amarelo. Todos os clipes serão 
ocultados, exceto aqueles marcados como favoritos. 

Na aba “Log and Capture”, clique no ícone de estrela ao lado do  
campo de nome caso deseje registrar o clipe como um favorito.

Vinculando um clipe de áudio a um clipe de vídeo
Como vincular um clipe de áudio a um clipe de vídeo na lista de mídias:

�� Selecione um clipe de vídeo que não contenha canais de áudio.

�� Clique no clipe de vídeo com o botão direito do mouse e selecione “Link Audio File”  
no menu contextual.

�� Navegue até o arquivo de áudio que você deseja vincular e clique em “Open”. O vídeo 
e o áudio serão vinculados na lista de mídias.

A lista de mídias fornece uma indicação altamente visível 
de que os clipes de vídeo e áudio estão vinculados.

Agora você pode reproduzir o clipe vinculado ou masterizá-lo para fita.

Excluindo clipes e ficheiros
Para excluir clipes, selecione os clipes indesejados e pressione a tecla backspace no 
seu teclado. 

Esta ação excluirá os clipes somente da lista de mídias e eles permanecerão armazenados em 
disco com segurança.

Para excluir ficheiros, clique dentro de um ficheiro com o botão direito do mouse e selecione 
“Delete Bin”. Esta ação excluirá o ficheiro e quaisquer clipes em seu interior. Esta ação excluirá os 
clipes somente da lista de mídias e eles permanecerão armazenados em disco com segurança.
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Criando um clipe 3D
Como adicionar um clipe 3D estereoscópico à lista de mídias:

�� Selecione um formato de vídeo do projeto 3D com a mesma taxa de quadros que 
sua mídia 3D.

�� Importe o arquivo “olho esquerdo” para a lista de mídias.

�� Clique com o botão direito do mouse no arquivo correspondente ao olho esquerdo 
e selecione “Set right eye clip” no menu contextual. Caso o clipe do olho direito 
tenha sido capturado pelo Media Express anteriormente, o vídeo do olho direito será 
nomeado com o texto “_right”.

Selecione um formato de vídeo do projeto 3D.

A lista de mídias fornece uma indicação altamente visível de que os clipes de vídeo e áudio 
estão vinculados. Os clipes de olho esquerdo e direito são exibidos lado a lado na janela 
“Video Preview”, indicando um projeto de vídeo 3D.

A lista de mídias fornece uma indicação altamente visível 
de que os clipes de vídeo e áudio estão vinculados.

Caso os olhos esquerdo e direito de um clipe estéreo 3D tenham sido carregados de  
maneira invertida:

�� Clique com o botão direito do mouse no clipe 3D na lista de mídias.

�� Selecione “Swap Eyes” no menu contextual.

Pesquisando na Lista de Mídias
Os clipes podem ser facilmente encontrados em um projeto. Basta digitar o nome dos seus 
clipes no campo de pesquisa na parte superior da lista de mídias. Quando utilizada em 
conjunto com o recurso “Favoritos”, a pesquisa será restrita aos seus clipes favoritos para que 
você veja uma lista mais curta de clipes encontrados.

Digite no campo de busca para encontrar clipes.
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Pontos de  
entrada/saída

Editando Arquivos de Vídeo e Áudio para Fita
Embora geralmente utilizemos a expressão masterizar ou editar para “fita”, não importa se  
o seu deck utiliza fitas ou discos. Como masterizar seus clipes:

�� Selecione os clipes que deseja enviar à fita.

�� Clique na aba azul “Edit to Tape”.

�� Configure o ponto de entrada e tipo de edição.

�� Inicie a masterização para fita.

Selecionando clipes para masterização
Na lista de mídias, selecione os clipes que deseja masterizar para fita. Você pode inclusive 
inserir clipes que contenham somente áudio multicanal para substituir a trilha de áudio master 
de uma fita master. Caso deseje enviar seus clipes favoritos para a fita, clique no ícone de 
favoritos (estrela) na parte superior da lista de mídias para exibir seus favoritos e ocultar todos 
os outros clipes. Em seguida, selecione os clipes favoritos que você deseja enviar para a fita.

Clique no ícone de favoritos (estrela) na parte superior da 
lista de mídias para exibir apenas os seus favoritos.

Inserir e Montar em fita
Clique na aba “Edit to Tape”. Defina o ponto de entrada da fita inserindo o código de tempo no 
campo “In” ou colocando a fita no ponto de entrada desejado através do controle de 
transporte e, em seguida, clicando no botão “Mark In”.

Caso nenhum ponto de saída seja inserido, o Media Express definirá a duração da edição 
como a duração total dos clipes na lista de mídias. Caso um ponto de saída seja configurado,  
o Media Express interromperá a gravação quando o ponto de saída for atingido, mesmo que 
alguns clipes não tenham sido transferidos.
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Dois clipes foram selecionados para gravação em fita.

Escolha masterização para fita usando o modo “Assemble” ou “Insert”. Em seguida, pressione  
o botão “Master”.

O modo “Preview” simula o processo de edição mas não grava em fita. Este modo permite  
que você verifique o ponto de edição. As operações de pré-visualização devem ser sempre 
verificadas em monitores conectados diretamente à saída do deck. Isso permite que você 
visualize o vídeo já em fita, assim como o novo vídeo. 

Caso o recurso “Record Inhibit” esteja habilitado no deck ou na fita, o Media Express irá 
alertá-lo quando você clicar no botão “Master”. Desabilite o recurso “Record Inhibit” antes de 
tentar novamente.

Selecione os canais de vídeo e áudio que deseja transferir através dos botões habilitar/
desabilitar trilha. Desabilite o canal de vídeo caso deseje transferir somente áudio.

Configure o número de canais de áudio que deseja masterizar.

Clique no ícone de favorito (estrela) na parte superior da lista de mídias para exibir apenas os 
seus favoritos.

Dois clipes foram selecionados para gravação em fita.

Configure o número de canais de áudio que deseja masterizar.

Capturando Vídeo H.265
Como capturar vídeo usando o codificador H.265 integrado ao Blackmagic UltraStudio 
4K Extreme:

1	 Abra as preferências do Media Express e configure “Capture File Format” para 
MP4 H.265.

2	 Configure a taxa de bits para a sua captura H.265 clicando no botão “Quality”, 
localizado ao lado do campo “Capture File Format”, e arrastando o deslizador 
“Encoding Settings” para a esquerda ou direita. Feche a janela “Encoding Settings” 
para confirmar a sua configuração. 

DICA  Para mais informações sobre as configurações de taxa de bits e captura H.265, 
consulte a próxima seção deste manual, ‘Codificador H.265 Físico’.
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Codificador H.265 Físico

Capturando Vídeo H.265 com UltraStudio 4K Extreme
O Blackmagic UltraStudio 4K Extreme possui um poderoso codificador H.265 integrado que 
permite capturar o vídeo H.265 em tempo real. Isso lhe dá a capacidade de capturar vídeo 
usando tecnologia de codificação que mantém uma qualidade de vídeo impressionante na 
menor taxa de bits possível.

Para capturar vídeo H.265 usando Blackmagic UltraStudio 4K Extreme, configure  
o formato de captura nas preferências do Media Express como MP4 H.265. 

Como capturar vídeo usando o codificador H.265 integrado:

1	 Inicie o software Blackmagic Media Express. Abra as preferências do Media Express e 
configure “Capture File Format” como MP4 H.265.

2	 Configure a taxa de bits para a sua captura H.265 clicando no botão “Quality”, 
localizado ao lado do campo “Capture File Format”, e arrastando o deslizador 
“Encoding Settings” para a esquerda ou direita. Feche a janela “Encoding Settings” 
para confirmar a sua configuração. Seu Blackmagic UltraStudio 4K Extreme está 
pronto para codificar vídeo H.265 usando o Blackmagic Media Express. Para mais 
informações sobre captura e reprodução de vídeo usando Media Express, consulte a 
seção ‘Blackmagic Media Express’ neste manual.

Configurando a Taxa de Bits
A taxa de bits padrão é configurada como 15 Mb/s, que é ideal para vídeos Ultra HD de alta 
qualidade transmitidos via streaming online, mas você pode configurá-la entre 3 e 50 Mb/s. 
Para streaming de vídeos HD online, recomenda-se uma taxa de 3 a 5 Mb/s.

Arraste o deslizador de “Encoding Settings” para a esquerda se você precisar capturar vídeo 
com um tamanho de arquivo menor e uma taxa de bits mais baixa; ou arraste para a direita se 
os tamanhos dos arquivos não forem um problema e você quiser a melhor qualidade de vídeo 
possível. Definir uma taxa de bits muito baixa resultará em artefatos de compressão em sua 
imagem, como macroblocagem, pixelamento ou posterização. No entanto, o codificador H.265 
físico é muito eficiente e minimiza o aparecimento de artefatos, assim é possível configurar uma 
taxa de bits mais baixa do que você normalmente faria para H.264 e ainda manter uma ótima 
qualidade de vídeo.
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Configure a taxa de bits para a captura H.265 clicando no botão “Quality”  
e arrastando o deslizador “Encoding Settings” para a esquerda ou direita.

Ao codificar vídeo H.265, ou realizar qualquer tipo de codificação de vídeo para streaming 
online, é importante considerar alguns fatores, como a largura de banda do seu sistema de 
entrega, a quantidade de movimento e contraste entre os quadros do seu vídeo e a taxa de 
quadro do seu vídeo. Por exemplo, se houver um grande número de pessoas fazendo o 
streaming do seu vídeo, talvez seja necessário reduzir a taxa de bits da sua codificação para 
que os usuários com conexões de internet mais lentas possam assistir sem interrupções. Taxas 
de bit mais elevadas são melhores para conteúdo de vídeo com muito contraste e movimento 
entre os quadros, como brilhante para escuro, ou eventos esportivos de alta energia e gráficos. 
Vídeos com taxas de quadro elevadas também exigem taxas de bit mais elevadas em 
comparação com os vídeos de taxas de quadro mais baixas.

Muitas vezes, a escolha da taxa de bits para a sua codificação pode ser um processo 
experimental em busca da melhor qualidade de vídeo com o menor tamanho de arquivo, 
portanto vale a pena testar uma variedade de ajustes de taxa de bits para obter os melhores 
resultados.

Blackmagic Disk Speed Test

O que é o Blackmagic Design Disk Speed Test?
O Blackmagic Design Disk Speed Test mede o desempenho de leitura e gravação de formatos 
de vídeo e taxas de quadros em mídias de armazenamento. O Disk Speed Test é incluso com o 
software Desktop Video e está disponível para download gratuito na App Store para macOS. 
As configurações do Disk Speed Test podem ser acessadas ao clicar no ícone de engrenagem, 
logo acima do botão “Start”.

Selecionar Drive de Destino

Clique em “Select Target Drive” e certifique-se que você tenha permissões de leitura 
e gravação.

Salvar Captura de Tela

Clique em “Save Screenshot” para salvar uma captura de tela dos resultados. 
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Stress

O nível de stress pode ser configurado entre 1 GB e 5 GB em incrementos de 1 GB.  
A configuração padrão é 5 GB, que fornecerá os resultados mais precisos.

Abra o menu “Settings” e clique  
no ícone de engrenagem.

Ajuda do Disk Speed Test

Clique em “Disk Speed Test Help” para abrir o manual do Blackmagic Disk Speed 
Test em PDF. 

Sobre o Disk Speed Test

“About Disk Speed Test” mostra qual versão do software Disk Speed Test está sendo 
executada.

Start

Clique no botão “Start” para iniciar o teste. O Disk Speed Test gravará um arquivo 
temporário no drive de destino selecionado e, em seguida, fará a leitura. O Disk Speed 
Test continuará a ler e gravar até que você pare o teste ao clicar no botão “Start” 
novamente.

Will it Work?

O painel “Will it Work?” exibe formatos de vídeo comuns e mostra um sinal de 
verificação ou um X para indicar se o desempenho do disco é adequado. É 
recomendável realizar vários ciclos de testes para revelar quaisquer formatos de vídeo 
para os quais o desempenho do sistema possa ser marginal. Caso observe um sinal de 
verificação e um X alternando entre si para um formato de vídeo, isto indica que o 
armazenamento em disco não suporta o formato de vídeo de forma eficaz.

How Fast? (FPS)

O painel de resultados “How Fast? (FPS)” exibe as taxas de quadro que podem ser 
alcançadas pelo seu drive e devem ser lidas em conjunto com o painel “Will it Work?”. 
Caso o painel “Will it Work?” exiba um sinal de confirmação verde para 2K DCI 25p em 
YUV 4:2:2 de 10 bits, mas o painel “How Fast? (FPS)” indicar que apenas um máximo de 
25 fps será compatível, o desempenho do armazenamento em disco será muito 
marginal para ser confiável.
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Configurações 
Clique neste botão para 
acessar as 
configurações antes de 
executar um teste de 
velocidade de disco.

START 
Clique neste botão uma 
vez para iniciar o teste de 
velocidade de disco. 
Clique novamente para 
interromper o teste.

How Fast (FPS) 
Este painel mostra os 
resultados em quadros por 
segundo (fps).

Will it Work? 
Este painel mostra quais 
formatos de vídeo são 
compatíveis com seu 
armazenamento em disco.

782Blackmagic Disk Speed Test



Removendo a Placa Mezanino 
da DeckLink 4K Extreme 12G 

Como Remover a Placa Mezanino 
Caso sua placa-mãe não tenha espaço suficiente para acomodar uma placa PCIe de porta 
dupla, você pode facilmente remover a placa mezanino da DeckLink 4K Extreme 12G.

Como remover a placa mezanino:

1	 Descarregue a eletricidade estática do seu corpo. Posicione a placa DeckLink de lado 
em uma superfície plana e limpa, com os contatos PCIe dourados voltados para cima.

2	 Na parte inferior da placa DeckLink, localize os dois parafusos que suportam a placa 
mezanino. Eles são os dois parafusos mais distantes dos conectores BNC. Remova os 
parafusos cuidadosamente utilizando uma chave Phillips.

3	 Segure a base da placa DeckLink pelas extremidades e levante a placa mezanino até 
que o seu conector ponte se solte do compartimento. 

4	 Certifique-se que o conector ponte esteja firmemente encaixado na placa mezanino 
caso você queira reencaixá-lo. 

5	 Mantenha os dois parafusos apertados no suporte, coloque a placa mezanino em um 
saco antiestático e armazene em um lugar seguro.

Agora você pode instalar sua placa DeckLink 4K Extreme 12G no seu computador usando um 
compartimento PCIe.

Como reencaixar a placa mezanino:

1	 Alinhe os dois suportes da placa mezanino com os orifícios dos parafusos em cada 
lado da base da placa DeckLink e encaixe a placa mezanino cuidadosamente no 
compartimento do conector ponte. Certifique-se que a placa mezanino esteja 
encaixada corretamente no compartimento. 

2	 Prenda os suportes à base da placa DeckLink apertando os parafusos com uma chave 
Phillips. Tome cuidado para não apertar demais os parafusos.

Caso necessite de assistência ou tenha alguma dúvida, visite a central de suporte técnico da 
Blackmagic Design em www.blackmagicdesign.com/br/support.

A placa mezanino da DeckLink 4K Extreme 12G pode ser removida facilmente.
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Recuperando uma Placa DeckLink 
Após uma Atualização Interrompida
Se você estiver atualizando uma placa DeckLink e o processo de atualização for interrompido, 
por exemplo, a alimentação é acidentalmente desconectada do seu computador, isso pode 
deixar sua placa em um estado inutilizável. No entanto, várias placas DeckLink possuem uma 
porta USB especial que permite fazer uma recuperação através de uma atualização.

Caso sua DeckLink suporte recuperação via USB, a porta USB tipo MiniB estará localizada na 
parte traseira ou lateral da sua placa. Esta porta USB permite que você plugue o seu 
computador e atualize sua placa diretamente.

Como recuperar uma atualização interrompida em uma placa DeckLink:

1	 Desligue o seu computador e desconecte a alimentação.

2	 Remova sua placa DeckLink cuidadosamente do compartimento PCIe do seu 
computador e coloque-a sobre uma superfície estável, como uma mesa ou bancada.  
É recomendável colocar a placa em um saco antiestático e usar uma pulseira 
antiestática para evitar o risco de danificar a placa através de um potencial 
choque elétrico.

3	 Plugue um cabo USB na porta USB tipo MiniB na parte traseira ou lateral da sua  
placa DeckLink. 

Remova a placa DeckLink do compartimento PCIe do seu computador e plugue-a no seu 
computador usando a porta USB tipo MiniB na parte traseira ou lateral da sua placa.

4	 Plugue a outra extremidade do cabo USB na porta USB do seu computador.
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5	 Conecte a alimentação e ligue o seu computador. Após a sequência de inicialização do 
seu computador, uma janela de alerta aparecerá pedindo que você atualize a placa. 

Clique em “Update”.

Uma barra de progresso indicará o processo de atualização e informará quando a 
atualização estiver concluída.

Uma vez concluída, desconecte o cabo USB e reinstale a placa no compartimento PCIe 
do seu computador.

OBSERVAÇÃO  Não se esqueça de desligar o computador e desconectar a 
alimentação antes de acessar o compartimento PCIe.

Com a sua placa reinstalada, agora você pode alimentar o seu computador. A placa DeckLink 
será reconhecida pelo seu computador e você poderá continuar com a sua produção.
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Ajuda

Obtendo Ajuda
A maneira mais rápida de obter ajuda é visitando as páginas de suporte online da 
Blackmagic Design e consultando os materiais de suporte mais recentes disponíveis para o seu 
Desktop Video.

Central de Suporte Técnico Online Blackmagic Design
O manual, o programa e as notas de suporte mais recentes podem ser encontrados na Central 
de Suporte Técnico da Blackmagic Design em www.blackmagicdesign.com/br/support.

Contatar o Suporte Blackmagic Design
Caso não encontre a ajuda que precisa no nosso material de suporte ou no fórum, por favor 
use o botão “Envie-nos um email” na página de suporte para nos encaminhar uma solicitação 
de suporte. Como alternativa, clique no botão “Encontre sua equipe de suporte local” na 
página de suporte e ligue para a sua assistência técnica da Blackmagic Design mais próxima.

Verificar a Versão de Software Atualmente Instalada
Para verificar qual versão do software Blackmagic Desktop Video Setup está instalada no seu 
computador, abra o Blackmagic Desktop Video Setup. 

ͽͽ No macOS, abra o Blackmagic Desktop Video Setup na pasta Aplicativos.  
O número da versão do software é exibido ao clicar em “Sobre Blackmagic Desktop 
Video Setup”. 

ͽͽ No Windows 7, clique no botão “Iniciar” e selecione “Todos os Aplicativos”. Desça 
até a pasta Blackmagic Design > Desktop Video e clique no aplicativo Blackmagic 
Desktop Video Setup. O número da versão do software é exibido clicando em 
“Sobre Blackmagic Desktop Video Setup”. 

ͽͽ No Windows 8 e 8.1, na página “Iniciar”, digite “Blackmagic” e clique no aplicativo 
Blackmagic Desktop Video Setup. O número da versão do software é exibido  
ao clicar em “Sobre Blackmagic Desktop Video Setup”. 

ͽͽ No Windows 10, clique no botão “Iniciar” e digite “Blackmagic” no campo de busca.  
Clique no aplicativo Blackmagic Desktop Video Setup. O número da versão do 
software é exibido ao clicar em “Sobre Blackmagic Desktop Video Setup”.

ͽͽ No Linux, vá até Aplicativos > Som e Vídeo e dê um clique duplo no aplicativo 
Blackmagic Desktop Video Setup. O número da versão do software é exibido  
ao clicar em “Sobre Blackmagic Desktop Video Setup”. 

Como Obter as Atualizações de Software Mais Recentes
Depois que verificar a versão do software Blackmagic Desktop Video Setup instalada no seu 
computador, visite a Central de Suporte Técnico da Blackmagic Design em  
www.blackmagicdesign.com/br/support para conferir as últimas atualizações. Embora seja  
uma boa ideia instalar as últimas atualizações, é recomendável evitar atualizar qualquer 
software caso esteja no meio de um projeto importante. 

Para verificar quando o seu driver foi atualizado pela última vez, clique na aba “Sobre” no 
utilitário Blackmagic Desktop Video. Você também pode gerar um relatório de status do drive 
clicando no botão “Create”.
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Informações para Desenvolvedores
Devenvolver Aplicativos Personalizados usando Equipamentos  
Blackmagic Design
O SDK DeckLink está disponível para que os desenvolvedores possam controlar equipamentos 
de vídeo Blackmagic com o seu próprio software personalizado. O SDK DeckLink é compatível 
com os produtos UltraStudio, DeckLink e Intensity.

O SDK DeckLink oferece tanto controle de nível baixo do hardware quanto de interfaces de 
alto nível para permitir que os desenvolvedores executem tarefas comuns facilmente.  
As tecnologias suportadas pelo SDK DeckLink incluem:

ͽͽ DeckLink API

ͽͽ Apple QuickTime

ͽͽ Apple Core Media 

ͽͽ Microsoft DirectShow

Baixando o SDK Blackmagic Design SDK Gratuito
O SDK DeckLink pode ser baixado em: www.blackmagicdesign.com/br/support

Juntar-se ao Fórum de Desenvolvedores de Software da Blackmagic Design
Se você está procurando respostas, comentários ou sugestões sobre tecnologias usadas pelo 
Blackmagic Design, como codecs, Core Media, APIs, SDK e muito mais, visite o nosso fórum de 
desenvolvedores. O fórum é um lugar útil para você se comunicar com a equipe de suporte 
Blackmagic Design e outros membros do fórum que possam responder a perguntas 
específicas do desenvolvedor e fornecer mais informações. O fórum de desenvolvedores de 
software se encontra dentro do Fórum Blackmagic Design em forum.blackmagicdesign.com

Contatar o Suporte Técnico a Desenvolvedores da Blackmagic Design
Caso deseje fazer perguntas fora do fórum de desenvolvedores, por favor entre em contato 
através do email developer@blackmagicdesign.com
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Informações Regulatórias
Descarte de Resíduos de Equipamentos Elétricos e Eletrônicos na União Europeia

O símbolo no produto indica que este equipamento não pode ser eliminado com 
outros materiais residuais. Para eliminar seus resíduos de equipamento, ele deve ser 
entregue a um ponto de coleta designado para reciclagem. A coleta separada e a 
reciclagem dos seus resíduos de equipamento no momento da eliminação ajudarão a 
preservar os recursos naturais e a garantir que sejam reciclados de uma maneira que 
proteja a saúde humana e o meio ambiente. Para mais informações sobre onde você 
pode entregar os resíduos do seu equipamento para reciclagem, por favor entre em 
contato com a agência de reciclagem local da sua cidade ou o revendedor do produto 
adquirido.

Este equipamento foi testado e respeita os limites para um dispositivo digital Classe A, 
conforme a Parte 15 das normas da FCC. Esses limites foram criados para fornecer 
proteção razoável contra interferências nocivas quando o equipamento é operado em 
um ambiente comercial. Este equipamento gera, usa e pode irradiar energia de 
radiofrequência e, se não for instalado ou usado de acordo com as instruções, poderá 
causar interferências nocivas nas comunicações via rádio. A operação deste produto 
em uma área residencial pode causar interferência nociva, nesse caso o usuário será 
solicitado a corrigir a interferência às suas próprias custas.

A operação está sujeita às duas condições a seguir:

1	 Este dispositivo não poderá causar interferência nociva. 

2	 Este dispositivo deve aceitar qualquer interferência recebida, incluindo 
interferência que possa causar  
uma operação indesejada.

Norma Canadense ISED

Este dispositivo cumpre com as exigências canadenses para aparelhos digitais 
de classe A.

Quaisquer modificações ou utilização deste produto fora dos limites previstos 
poderão anular a conformidade com estas normas.

A conexão com interfaces HDMI devem ser feitas com cabos HDMI protegidos.

Este equipamento foi testado para fins de cumprimento com a sua utilização 
pretendida em um ambiente comercial. Se o equipamento for usado em um 
ambiente doméstico, ele poderá causar interferência radioelétrica.
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Informações de Segurança
Para proteção contra choque elétrico, o equipamento deve estar conectado à uma tomada com 
conexão de aterramento de proteção. Em caso de dúvida, consulte um eletricista qualificado.

Para reduzir o risco de choque elétrico, não exponha este equipamento a pingos ou respingos.

O produto é adequado para uso em locais tropicais com temperatura ambiente de até 40oC. 

Certifique-se de que ventilação adequada seja fornecida ao redor do produto e não esteja 
restringida.

Ao montar o produto em rack, certifique-se de que a ventilação não esteja restringida por 
equipamentos adjacentes.

Não há componentes internos reparáveis pelo operador. Solicite o serviço de manutenção à 
assistência técnica local da Blackmagic Design.

Alguns produtos têm os recursos de conexão para módulos transceptores de fibra óptica com 
fator de forma SFP. Use apenas módulos SFP ópticos de Laser de classe 1.

Módulos SFP recomendados pela Blackmagic Design:

ͽͽ 3G-SDI: PL-4F20-311C

ͽͽ 6G-SDI: PL-8F10-311C

ͽͽ 12G-SDI: PL-TG10-311C

Utilize apenas em altitudes inferiores a 2000 m acima do nível do mar.

Declaração do Estado da Califórnia

Este produto pode expô-lo a produtos químicos, tais como vestígios de bifenilos polibromados 
dentro de peças de plástico, considerados pelo estado da Califórnia como causadores de 
câncer e defeitos congênitos ou outros danos reprodutivos.

Para mais informações, visite www.P65Warnings.ca.gov.

Aviso para Pessoal de Assistência Autorizado 
Desconecte a alimentação de ambas as entradas de alimentação antes de 
efetuar operações de assistência!

Cuidado – Interruptor Bipolar/ Aterramento Neutro 

A fonte de alimentação neste equipamento possui um fusível tanto nos 
condutores de linha quanto neutro e é adequada para conexão com o sistema 
de distribuição de alimentação IT na Noruega.
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Garantia

Garantia Limitada
A Blackmagic Design garante que as linhas de produtos UltraStudio, DeckLink e Multibridge 
estarão livres de defeitos de materiais e fabricação por um período de 36 meses a partir da data 
de compra, excluindo conectores, cabos, módulos de fibra ótica, fusíveis e baterias que estarão 
livres de defeitos de materiais e fabricação por um período de 12 meses a partir da data de compra. 
A Blackmagic Design garante que a linha de produtos Intensity estará livre de defeitos de materiais 
e fabricação por um período de 12 meses a partir da data de compra. Se o produto se revelar 
defeituoso durante este período de garantia, a Blackmagic Design, a seu critério, consertará o 
produto defeituoso sem cobrança pelos componentes e mão-de-obra, ou fornecerá a substituição 
em troca pelo produto defeituoso. 

Para obter o serviço sob esta garantia você, o Consumidor, deve notificar a Blackmagic Design 
do defeito antes da expiração do período de garantia e tomar as providências necessárias para 
o desempenho do serviço. O Consumidor é responsável pelo empacotamento e envio do produto 
defeituoso para um centro de assistência designado pela Blackmagic Design com os custos de 
envio pré-pagos. O Consumidor é responsável pelo pagamento de todos os custos de envio, 
seguro, taxas, impostos e quaisquer outros custos para os produtos que nos forem devolvidos 
por qualquer razão. 

Esta garantia não se aplica a defeitos, falhas ou danos causados por uso inadequado ou manutenção 
e cuidado inadequado ou impróprio. A Blackmagic Design não é obrigada a fornecer serviços 
sob esta garantia: a) para consertar danos causados por tentativas de instalar, consertar ou fornecer 
assistência técnica ao produto por pessoas que não sejam representantes da Blackmagic Design, 
b) para consertar danos causados por uso ou conexão imprópria a equipamentos não compatíveis, 
c) para consertar danos ou falhas causadas pelo uso de componentes ou materiais que não são 
da Blackmagic Design, d) para fornecer assistência técnica de um produto que foi modificado ou 
integrado a outros produtos quando o efeito de tal modificação ou integração aumenta o tempo 
ou a dificuldade da assistência técnica do serviço. ESTA GARANTIA É FORNECIDA PELA 
BLACKMAGIC DESIGN NO LUGAR DE QUAISQUER OUTRAS GARANTIAS, EXPLÍCITAS OU 
IMPLÍCITAS. A BLACKMAGIC DESIGN E SEUS FORNECEDORES NEGAM QUAISQUER GARANTIAS 
IMPLÍCITAS DE COMERCIALIZAÇÃO OU ADEQUAÇÃO A UMA FINALIDADE ESPECÍFICA. A 
RESPONSABILIDADE DA BLACKMAGIC DESIGN DE CONSERTAR OU SUBSTITUIR PRODUTOS 
DEFEITUOSOS É A ÚNICA E EXCLUSIVA MEDIDA FORNECIDA AO CONSUMIDOR PARA QUAISQUER 
DANOS INDIRETOS, ESPECIAIS OU ACIDENTAIS INDEPENDENTEMENTE DA BLACKMAGIC 
DESIGN OU DO FORNECEDOR TIVER INFORMAÇÃO PRÉVIA SOBRE A POSSIBILIDADE DE TAIS 
DANOS. A BLACKMAGIC DESIGN NÃO É RESPONSÁVEL POR QUAISQUER USOS ILEGAIS DO 
EQUIPAMENTO PELO CONSUMIDOR. A BLACKMAGIC NÃO É RESPONSÁVEL POR QUAISQUER 
DANOS CAUSADOS PELO USO DESTE PRODUTO. O USUÁRIO DEVE OPERAR ESTE PRODUTO 
POR CONTA E RISCO PRÓPRIOS. 

© Direitos autorais 2019 Blackmagic Design. Todos os direitos reservados. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’,  
‘Videohub’, ‘DeckLink’, ‘Intensity’ and ‘Leading the creative video revolution’ são marcas comerciais registradas nos Estados 
Unidos e em outros países. Todos os outros nomes de empresas e produtos podem ser marcas comerciais de suas respectivas 
empresas com as quais elas são associadas.

Thunderbolt e o logotipo Thunderbolt são marcas registradas da Intel Corporation nos Estados Unidos e/ou em outros países.
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